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Preface: Introduction to PRweb

Preface: Introduction to PRweb

The AcquiLine suite of products, developed by American Management Systems (AMYS)), is
targeted at achieving paper-free business processes. AcquiLine is a web-based product suite that
is a “bolt-on” to the Standard Procurement System (SPS) program’s Procurement Desktop-
Defense (PD?) system. The AcquiLine PRweb module is a direct paperless channel between the
requesting agent and a Contracting Office’s PD? database. With the PRweb module, the
requesting agent can create Purchase Requests, with attachments, for supplies and services directly
from a desktop web browser. After creating a Purchase Request, the PRweb user can route it to
other PRweb users in the organization for additional information, changes, funding commitment,
and package approval, all according to locally defined business practices. Once the Purchase
Request is approved, the information is saved directly to the PD* database at the Contracting
Office. Procurement officials can then utilize the full power of PD to fulfill the requirement as
submitted, or can route the requirement back to the PRweb user if further clarification is needed.

The PRweb module also allows customers to view PR status information through their desktop
web browser. This capability saves the requesting agent and Contracting Office valuable time,
providing customer self-service rather than necessitating a phone call or e-mail status inquiry to
the Contracting Office.

The PRweb Functional User’s Guide is designed to be a comprehensive manual providing detailed
procedures for the various system features of the product. The effective use of this manual is to
ensure successful use of PRweb. The manual is divided into twelve sections: Getting Started,
PRweb Desktop, Account Maintenance, Purchase Request, PR Modifications, Line Item,
Attachments, DD254, Workflow, Reports, Transfer Document and Help.

AcquiLine PRweb v2.3 1 July 29, 2002
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Chapter 1: Getting Started

Chapter 1: Getting Started

The PRweb desktop allows the requesting agent to -

successfully perform procurement-related tasks. A In This Chapter...
requesting agent in PRweb has the capability of
creating, viewing, editing, routing and approving PRs
from the PRweb desktop. Maintenance of the PRweb
user account allows the user to access PRweb, e  Register for access to PRweb
become familiar with desktop functionality and set
user preferences.

Using the functions described in this
chapter you can:

e Logonto PRweb

Accessing PRweb

A valid user account is required to access PRweb. To obtain an account, the registrant must
complete the registration form, which then needs to be approved by the designated System
Administrator. Alternatively, a user account can be created directly by the System Administrator.
Upon completion of either of these two options, the user can log on to the PRweb module. The
login process requires the registrant to successfully enter a username and password. Upon
successful log on, the user has access to the PRweb desktop and can participate in the
requirements phase of the procurement process.

AcquiLine PRweb v2.3 2 July 29, 2002
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Chapter 1: Getting Started

Information Tab

The Login window opens to the Information tab. The Information tab provides a location in
which the System Administrator can post information or messages for PRweb users to see. It is
recommended that the user read the Information tab upon login.

Information | Lu:uginl Fegistration

F Y

Information mstrmetions raay be edited in Site Ilanagement.

Figure 1: Login — Information Tab
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Chapter 1: Getting Started

Login Tab

PRweb users can access the PRweb module via the Login window.

Figure 2: Login — Login Tab

To log on to the PRweb module:
1. Click the Login tab from the Login window.
2. Enter the username in the Username field.

3. Enter the corresponding password in the Password field.

Note: The password entered must be a minimum of 8 characters including one or more special
characters (e.g., “%” or “#”).

4. Click the [Login] button.

Acquiline PRweb v2.3 4 July 29, 2002
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Chapter 1: Getting Started

Registration Tab

The Registration tab is the location in which a person begins the registration process to become a
PRweb user.

To register as a PRweb user:

1. Select the Registration tab from the Login window.

Infarmation | Login Rﬂgis‘tra‘tinnl

Fegiztration instructions may be edited in Site Management.

R egistration |

Figure 3: Login — Registration Tab
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Chapter 1: Getting Started

2. Click the [Registration] button.
The Registration Form window opens with the User tab displayed.

User Tab

i Registration Form [_ (O] x|

Farm

User | Cn:nntactl Grnupsl

Izernarme: I

Pazzwaord: I

hWerify: I

Fequested Rights:

[ Administratar

[ Wiew FPRweb PRz in Status Feport
[ Wiew &ll PR3 in Status Feport

|'W'arning: Applet \windom

Figure 4: Registration Form — User Tab

1. Enter a username in the Username field.

Note:  All username information is account specific. No two users may have the same
username.

2. Enter a password in the Password field.

Note:  The password entered must be a minimum of 8 characters including one or more special
characters (e.g., “%” or “#”).

3. Verify the password by re-entering it in the Verify field.

4. Ifapplicable, select the Administrator check box.

Note: The View PRweb PRs in Status Report check box and View All PRs in Status Report
check box are disabled if the Administrator check box is selected.

5. [Ifapplicable, select the View PRweb PRs in Status Report check box.

Selecting the View PRweb PRs in Status Report check box requests the right to use the PR
Status Report function to view PRs that have been created in PRweb and reside in PD*. For
more information on PR Status Report, refer to the “PR Status Report” section in Chapter
10: Reports.

AcquiLine PRweb v2.3 6 July 29, 2002
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6. If applicable, select the View All PRs in Status Report check box.

Selecting the View All PRs in Status Report check box requests the right to use the PR
Status Report function to view all PRs that reside in PD? including PRs created in PRweb.
For more information on PR Status Report, refer to the “PR Status Report” section in
Chapter 10: Reports.

Contact Tab

1. Click the Contact tab.

The information contained on the Contact tab provides a profile for the user account. The
contact information includes Contact Name, Title, Phone number, Fax number, E-mail
address and a Requesting Office address. If contact information needs to be changed or
updated after registration, contact the PRweb System Administrator.

i Registration Form M=l E3
Forrn

Uzer Contact | Groups |

[T Check here if you are an existing Contact in PDE. Then press
the Select button below ta find your Contact prafile.

SElERh.. | EEmaye |

Contact Marme: I

Title:

|
Phione: I Fau:
|

E -mail:

R equesting
Office:

Select... |

|'W'arning: Applet Window

Figure 5: Registration Form — Contact Tab

Note:  Select the Check here if you are an existing Contact in PD?... check box to choose an
existing contact in PD?. This activates the [Select] and [Remove] buttons. Clicking the
[Select] button allows the registrant to search for existing contact information contained
in PD” Clicking the [Remove] button erases any contact information previously pulled
from PD”. If an existing contact is selected, the fields on the Contact tab populate with
the information pertaining to that contact.

2. Enter a name in the Contact Name field.

This is a required field. The contact name displays in the user list when creating route
templates, routing sheets and groups.

3. Enter the contact’s title in the Title field.

AcquiLine PRweb v2.3 7 July 29, 2002
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4. Enter the contact’s phone number in the Phone field.
5. Enter the contact’s fax number in the Fax field.

6. Enter the contact’s e-mail address in the E-mail field.

This is a required field.

7. Click the [Select] button to select a Requesting Office.
The Requesting Office Contact Search window opens.

Note: The Requesting Office field on the PR defaults to the Requesting Office selected by the
contact during the registration process. The registrant can search for an existing contact
or add a new one.

Requesting Office Contact Search Ed

Search Criteria Search By
IE * Code " Organization Mame
" Contact Mame " Phote Murnber
Search | SElest | Cancel | £ State £ Zip Code
Contact | Code | Organization | City | State | Zip Code FH
Kl 3

|Warning: Applet Window

Figure 6: Requesting Office Contact Search Window

8. Enter Search Criteria, and click the [Search] button.

Note:  For more information on searches, refer to “Search Function” section in Chapter 2:
PRweb Desktop.

9. Highlight the desired Requesting Office and click the [Select] button.

The Contact tab displays with the selected Requesting Office in the Requesting Office
field.

AcquiLine PRweb v2.3 8 July 29, 2002
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i Registration Form |_ (O] x|

Farm

Uzer Contact | Groups |

[ Check here if you are an existing Contact in PD2. Then press
the Select button below ta find your Contact profile.

Select., | Eemowe |

Contact Mame: Iacquser'l

Title: Ia-:quser'l

Phane: | 555-4321 Faw |555-4321

E-rnail: Iacquser'l (@jag. com

Requesting Training Center ﬂ
Dffice: ATTM: ATZ)-DOC

Remaove | Building 4340 ;I

|Warning: Applet window

Figure 7: Registration Form — Contact Tab
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Groups Tab

1. Click the Groups tab.

The PRweb module utilizes groups to organize users with commonalties and helps to organize
the approval trail. There are two tabs within the Groups tab, the Member tab and Manager
tab. The Member tab allows the registrant to request membership of a group and the Manager
tab allows the registrant to request to be a manager of a group.

Member Tab

The Member tab allows a registrant to request membership of a group. The PRweb routing
components allows the user to route PRs to groups of users. For more information on routing,
refer to the “Routing” section in Chapter 9: Workflow.

i Registration Form H=] E3
Forrn

Llserl Cortact Groups |

Member | Managerl

MName | Drezcription Add...

HEmoye |

|'W'arning: Applet Window

Figure 8: Registration Form - Groups Tab - Member Tab

Click the [Add] button to search for a group.

The Group Search window opens.

Note: It is not required that a registrant be a member of a group.

AcquiLine PRweb v2.3 10 July 29, 2002
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Group Search
Search Criteria Search By
IE % pame = Description
Search | Selest | Cancel |
M ame | Dezcription

|Warning: Applet Windaw

Figure 9: Group Search Window

2. Enter Search Criteria, and click the [Search] button.

Note:  For more information regarding searches, refer to “Search Function” section in Chapter
2: PRweb Desktop.

3. Highlight the desired group(s) and click the [Select] button.
The Member tab displays with the selected group(s).

Note: Multiple groups can be selected by pressing the <Ctrl> key and clicking on the desired
groups.

AcquiLine PRweb v2.3 11 July 29, 2002
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i Registration Form Hi=] E3
Forrm

Llserl Contact  Groups |

Member | Managerl

Marme | Crezcription PoAdd

Adrmin Training 1 ;
HEmoye |

|Warning: Applet window

Figure 10: Registration Form - Groups Tab - Member Tab

Note:  For a quick way to search a list, refer to the ‘Searching Within A List” section in Chapter
2: PRweb Desktop.

Manager Tab

The Manager tab allows a registrant to request to be a manager of one or more groups.
Managers of groups can use PR Status Reports to view PRs that currently reside in PD* and
were created by members of the groups they manage. For more information on PR Status
Report, refer to “PR Status Report” section in Chapter 10: Reports.

AcquiLine PRweb v2.3 12 July 29, 2002
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i Registration Form Hi=] E3
Forrm

Llserl Contact  Groups |

Member Manager |

M amne | Description Add...

HEmoye |

|Warning: Applet window

Figure 11: Registration Form — Groups Tab - Manager Tab

1. Click the [Add] button to search for a group.

The Group Search window opens.

Note: It is not required that a registrant be a manager of a group.

Group Search
Search Criteria Search By
IE &+ Mame " Description
Search | Selest | Cancel |
M arme | Dezcription

|Warning: Applet "Window

Figure 12: Group Search Window
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2. Enter Search Criteria, and click the [Search] button.

Note: For more information regarding searches, refer to “Search Function” section in Chapter
2: PRweb Desktop.

3. Highlight the desired group(s) and click the [Select] button.
The Groups tab displays with the selected group.

Note: Multiple groups can be selected by pressing the <Ctrl> key and clicking on the desired
groups.

i Registration Form M=l E3

Farm

Userl Cortact  Groups |

Member Manager |

Mame | D ezcription

Adrin Training 1 :
Hermae |

|'W'arning: Applet Window

Figure 13: Registration Form — Groups Tab - Manager Tab

Note: For a quick way to search a list, refer to the ‘Searching Within A List” section in Chapter
2: PRweb Desktop.

4. To submit the Registration Form, select Form - Submit from the Registration Form
menu bar.

AcquiLine PRweb v2.3 14 July 29, 2002
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S [=] E3

i Registration Form

Subrmit

Graups |
Catizel
TTEETT e, acquzer]
Paszward: Ixxxxxxxxx
l"."'Efif_lrli Ixxxxxxxxx

Requested Rightz:

[T Admiristrator

¥ Wiew PRweb PRz in Status Report
[V Wiew All PRs in Status Feport

|Warning: Applet window

Figure 14: Submit Menu Option

An e-mail alert from the PRweb System Administrator is sent to the contact’s e-mail

Note:
address upon registration approval or rejection.
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Functional User’s Guide



Chapter 2: PRweb Desktop

Chapter 2: PRweb Desktop

File Menu In This Chapter...

The File menu provides desktop functions to allow
the PRweb user to update or exit the desktop. For
these purposes, three components are provided in the
File menu: Refresh Folder, Refresh All, and Exit. e  Understand the desktop
functions and components

e  Use the Search feature

Using the functions described in this
chapter, you can:

e Use the Auto-Calendar feature

& PRweb =10 x|
=W Freferences  Purchaze Reguest Help

Refresh Folder
Refresh All
Exit

I I Sy

I.Ja\-'a Applet Window

Figure 15: File Menu
AcquiLine PRweb v2.3 16 July 29, 2002
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Chapter 2: PRweb Desktop

Refresh Folder

The Refresh Folder menu option allows the PRweb user to refresh individual folders to reflect
changes. For example, if a user gets an e-mail alert regarding a new PR in his/her Inbox, but does
not see the PR in that folder, he/she can highlight the Inbox folder and select File > Refresh
Folder from the desktop menu bar. This refreshes the /nbox folder with the new information and
the PR displays in that folder.

Refresh All

The Refresh All menu option allows the PRweb user to refresh all folders on the desktop to reflect
changes. For example, if a user adds an attachment to a PR but does not see the attachment icon
on the desktop, he/she can select File > Refresh All from the desktop menu bar. This refreshes
all folders on the desktop with any new information. The PR icon now reflects the addition of the
attachment.

Exit
PRweb users can exit the desktop by selecting File = Exit from the desktop menu bar.

AcquiLine PRweb v2.3 17 July 29, 2002
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Using Desktop Components

The PRweb desktop is a Graphical User Interface (GUI) that provides the user control and
interaction with the program.

=10 x|

B[] Archive

I Ty

IJava Applet \Window

Figure 16: Desktop

Desktop Folders

The PRweb desktop is the large white area that holds all of the PRweb user’s PRs in four folders:
Drafts, Inbox, Outbox and Archive. Each folder represents a stage in the requirements
development process.

e The Drafts folder contains PRs that have been created but not yet routed. PRs that have been
re-routed back to PRweb from PD? also display in the Drafts folder.

e  The Inbox folder contains PRs that have been routed to the user for review and approval by
another PRweb user.

e  The Outbox folder contains PRs that have been routed to another PRweb user.

e  The Archive folder contains PRs that have proceeded through the approval process in the
PRweb module and now reside in the PD? database.

To access a document contained within a folder:

AcquiLine PRweb v2.3 18 July 29, 2002
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1. Click on the plus symbol (+) to open a folder and display the folder’s contents.

The (+) symbol denotes that a closed folder has one or more documents in it.

2. Double-click the document to be opened.

Note: The minus symbol (-) that displays directly to the left of an open folder allows the user to
close that folder.

Title Bar

A title bar displays the name of the window at the top of every window in the PRweb system.
Throughout this document, the name contained within the title bar is used as the window name.

: PRweb M= E |

Figure 17: Title Bar

Menu Bar

The menu bar allows the user to efficiently and quickly navigate through the various functions and
capabilities of the PRweb module. The menu bar is the strip of one or more words located across
the top of a window, below the title bar. Each word in the menu bar can be selected to activate a
drop-down menu. Each drop-down menu contains words that relate to the various options
provided in the program that can be selected to link the user to that option.

File Adminiztration Help

Figure 18: Desktop Menu Bar

Username

The username is displayed in the bottom right corner of the desktop. This identifies the user who
is logged in.

Java Applet Window or Warning: Applet Window

Either the “Java Applet Window” or “Warning: Applet Window” message displays in the
lower left corner of the PRweb desktop. It serves as a reminder that the PRweb module is not a
program that resides on the hard drive of the user’s computer, unlike a word processor or a
spreadsheet program. The PRweb module is a Java Applet, a special type of program that can be
used over the Internet.

AcquiLine PRweb v2.3 19 July 29, 2002
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Search Function

There are two search functions available in PRweb, searching the database and searching a list.
The searching the database function allows the PRweb user to pull information directly from the
PRweb or PD? database. The searching within a list function allows the PRweb user to search a
list quickly.

Searching the Database

To conduct a search:

1. Click the [Select] button for the appropriate Search box.

Requesting Office Contact Search
Search Criteria Search By
IE ' Code ™ Organization Mame
" ContactMame  © Phone Mumber
i~ State i~ ZFip Code
Mew. ..

Search | Select | Cancel |

Contact | Code | Crganization | City | State | Zip Code Ph

=l 3
|Warning: Applet window

Figure 19: Sample Search Window

2. Qualify the Search Criteria field by selecting the desired Search By radio button.

The Search By radio buttons enables the PRweb user to perform searches by specific
categories. The search results display the specific category alphabetically.

3. Define the criteria in the Search Criteria field.

The Search Criteria field allows the PRweb user to further define and refine the search
parameters. The PRweb module employs the universal search symbol (%) to aid in the search
process. The universal search symbol pulls all information pertaining to the designated search
parameter. For example, “A%” in the Requesting Office Contact- Search field displays all
vendors beginning with the letter A. The % may also be used to search for a keyword. For
example, “%Army%>" in the Requesting Office Contact Search field displays all Requesting
Offices containing the word “Army.”

AcquiLine PRweb v2.3 20 July 29, 2002
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Note: The Search Criteria field is case-sensitive.

4. Click the [Search] button.

Requesting Office Contact Search Ed
Search Criteria Search By
|,.i-.,|_z " Code " Organization Mame
" Contact Mame " Phote Murnber
© Search Select | Canicel |  State " Zip Code
Contact Code Organization City State | Zip Code =

BREMDAM HAG S01024 CPRO PEMCO AEROPL BIRMINGHAM 35202-2447
MO COMTACTS SO1024 CDPRO PEMCO AEROPL BIRMIMGHAM AL 35202-2447
#-5MITH DAACDT AMNISTOM ARMY DEP ANMISTOM Al 36201-5003
MO COMTACTS DAACO AMMISTOM &RMY DEP AMMISTOMN Al 36201-5003
MNO COMTACTS DAAHO USA MISSILE COMMAN REDSTONE &R AL 35838-5280
WO COWNTACTS DABTOZ L5, ARMY CHEMICAL, FORT MCCLELL AL 3E205-5000
MO COMTACTS DACAM US4 EMGIMEER DISTR MOBILE Al 36E228-00M
HO COMTACTS DACWOT  US&ENGINEER DISTR MOEILE Al 366253-00M
MO COMTACTS DACAZY USA EMGIMEER DRISI HUNTSWILLE AL 35807-43M
MO COMTACTS DACWSEY  USAEMGIMEER DPMISI HUMTSWILLE AL 35807-43M

Kl 3
|Warning: Applet Window

Figure 20: Sample Search Results

5. Highlight the desired result and click the [Select] button.
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Searching Within A List

To conduct a search:

1. Click on the appropriate list.

i Registration Form Hi=] E3
Forrm

Llserl Contact  Groups |

Member | Manager |
M amne Description Add...
ELS#1 Bus Level 5 ecurity Remove |
BLSH2 BLSH2
BLSH3 BLSH2
BLSH4 BLSH4
Group 2 Betsy's group 2
Eroup 3 Betzy's Group 3
Group 4 Betzy's group 4
TRA Training Group
TRA1 Training Group
TRAZ 2nd Training Group
TRAR Training

|Warning: Applet window

Figure 21: Registration Form - Groups Tab - Member Tab

2. Enter search text.

The Starts with window opens.

Note: More than one character may be typed in the Search Text field.

Startz with. ..
Search Text: OF. |
IT Cancel |

|'W'arning: Applet \Wwindow

Figure 22: Starts With Window

3. Click [OK].
The search results is highlighted.
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: Registration Form
Form

Llserl Contact  'Groups |

=] E3

Member | Managerl

WETE | Dezcriptian Add...
Adrin Training 1
BLSH#1 Bus Level Security Remave |
BLSH2 BLSHZ
BLSH2 BLSHI
BLSH4 BLSH4
Group 2 Betzy's group 2
Group 3 Betzy's Group 3
GrDuE 4 BEtSEIS irnuE 4
TRA1 Training Group
TRaZ 2nd Training Group
TRAR Training

|Warning: Applet Window

Figure 23: Registration Form - Groups Tab - Member Tab
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Auto-Calendar Feature

The Auto-Calendar feature allows the PRweb user to quickly select a date from a calendar

interface.

To use the Auto-Calendar feature:

1. Place the cursor inside the field that requires a date.

2. Press <Shift> and double-click the left mouse button.

[2002 7] Tos |

Sun Mon Twe Wed Thu  Fri Sat
1 213|456 |7
B9 |11 (1213 14

15 |16 | 17 | 18 | 19 | 20 | 21
2324|2528

(8] 4

| Cancel |

8|8 |01 ]12]

Jawva spplet Window

Figure 24: Calendar Window

Note: A calendar displays with the current date as the default.

Note: Clicking on the auto-calendar icon also displays the calendar. %

3. Use the Month drop-down list box to select a different month if necessary.

4. Use the Year drop-down list box to select a different year.

5. Click the desired day of the month in the calendar that displays.

6. Double-click the appropriate date or single-click a date and click [OK] to select and close the

calendar.

AcquiLine PRweb v2.3
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Chapter 3: Account Maintenance

The PRweb desktop allows the requesting agent to
successfully perform procurement-related tasks. A
requesting agent in PRweb has the capability of
creating, viewing, editing, routing and approving
PRs from the PRweb desktop. Maintenance of the
PRweb user account allows the user to access
PRweb, become familiar with desktop functionality
and set user preferences.

Customizing the User Account

In This Chapter...

This chapter introduces the basic
information needed to begin working
with AcquiLine PRweb. This includes:

e Customizing the user account

The Preferences menu allows the PRweb user to customize his/her user options. The Preferences
menu contains five options: Change Archive Days, Change Password, Route Templates,

Change E-mail Address, and Out of Office.

AcquiLine PRweb v2.3 25
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M= 3
=gl Puichaze Request Help
E Change &rchive Days...
i & Change Pazzword...
@
e Route Templates...
Change E-mail Address...
(it of Office...
| it ay
|Warning: Applet Window

Figure 25: Preferences Menu Option

Change Archive Days

The Change Archive Days menu option allows the PRweb user to specify the number of days that
PRs are displayed in the Archive folder. Changing the number of days overwrites the default set
by the System Administrator.

To change the number of archive days:
1. From the menu, select Preferences > Change Archive Days.
The Archive Days window opens.
Archive Days

E riter the number of days, from the
creation date, that PR documents are
wizible fram within the Archive folder.

s

Ok, Cancel

|Warning: Applet Window

Figure 26: Archive Days Window
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2. Enter the desired number of days.

3. Click [OK] to save the Archive Days setting.

The Attention window opens.

Attention

& our Archiving D ayz value has been updated.

|'W'arning: Applet "Window

Figure 27: Attention Window

4. Click [OK] to return to the PRweb desktop.
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Change Password

The Change Password feature allows the PRweb user to change his/her login password.
To change passwords:
1. From the menu, select Preferences > Change Password.

Change Paszword Ed

0ld Pazsword: ||

Mew Passwaord: I

W erify: I

k. Cancel

|Warning: Applet Window

Figure 28: Change Password Window
2. Enter the current password in the Old Password field.
This is a required field.

3. Enter the desired password in the New Password field.

This is a required field.

Note:  The password entered must be a minimum of 8 characters including one or more special
characters (e.g., “%” or “#”).

4. Re-enter the desired password in the Verify field.
This is a required field.

5. Click [OK] to change the password.

The Attention window opens.

Attention

& Your pazsward has been changed.

|Warning: Applet "Window

Figure 29: Attention Window

6. Click [OK] to return to the PRweb desktop.
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Route Templates

The Route Templates feature allows the PRweb user to create his/her own specific route
templates to complement current approval processes. Only users with appropriate security rights
can create route templates. Members of security groups that only have routing access to specific
templates can choose from those templates to which they are assigned when routing a PR. The
routing sheet populates with the contents of the template. Therefore, the order in which users are

put on the route template is the order in which the PR is routed.

Creating a Route Template

The PRweb user can create new route templates. Route templates can be created to complement

current approval processes.

To create a route template:

1. From the menu, select Preferences > Route Templates.

i Templates M =]
Name | D ESD”ptIDn .......... NEW ............. |
Adrir, Adminiztrators Temnplate :
Testing Test Template Edit..

<] I

= Cloze

|Warning: Applet '

o

Figure 30: Templates Window

Note: For a quick way to search a list, refer to the ‘Searching Within A List” section in Chapter

2: PRweb Desktop.

AcquiLine PRweb v2.3
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2.

Click the [New] button.

The Template — New window opens.

Template - Hew

M arne: ||

Description: |

Yiew Houtees By -

e |Jzer
" Group

Man-tMembers

s

ACHUSERC
&CH USER D
ACH USER E
&CHUSER F
ACQUILIME USERA
ACOUSER B
ACOUSERTD
ACOUSERTD
&L GAMZEMULLER
BaRBARA E BROCK

tembers

Foute to PDE User:; I

Select. . |

Wiew Groups... |

Cancel I

ok |

|Warning: Applet window

Figure 31: Template — New Window

Enter a unique template name in the Name field.

A unique name is required for each template. The Name field holds up to 30 characters.

Enter a description for the new template in the Description field.

The template description allows the System Administrator to further clarify the route template
he/she is creating. The Description field holds up to 255 characters.

Select members for the new template by highlighting desired users from the Non-Members
list box and clicking the [ p ] button.

Note:

2: PRweb Desktop.

For a quick way to search a list, refer to the ‘Searching Within A List” section in Chapter

Note:

The Non-Members list box displays all available users to add to the route template. As

users are added to the route template their usernames display in order selected in the
Members list box and are subsequently removed from the Non-Members list box.
Members can be removed from the route template by highlighting the desired user from
the Members list box and clicking the [ 4 ] button.

AcquiLine PRweb v2.3
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6. Select the Group radio button from the View Routees By field.

7. Select a member from the Non-Members list.

8. Click the [View Group] button.

The Groups (Read Only) window opens.

i Groups [Read Only) M[=] E3

M ame

BLSH1
BLSHZ
BLSH3
BLSH4
Group 2
Group 3
Group 4
Group &
Group B
Group 7

Description

Busz Level Security
BLSHZ2

BLSH3

BLSH4

Betzy's group 2
Betzy's Group 3
Betzy's group 4
Betsy's Graup &
Betzy'z group B
Betsy's group 7

-

<]

Opeh... |

Cloze

|Warning: Applet Window

9. Click the [Close] button to return to the Template — New window.

Figure 32: Groups (Read Only) Window

10. Click [OK] to save the new template and return to the Templates window.

11. Click the [Select] button next to the Route to PD* User field.

The Select PD? User window opens.

Select PDZ User

PD Uszer?
Drarminic Joel

Sarah Jopce
Sypstem Adminigtrator

Selent

Cancel

|Warning: Applet 'Aindow

Figure 33: Select PD’ User Window

12. Highlight the appropriate Contract Official.
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13. Click the [Select] button.
The PD’ user selected displays in the Route to PD’ User field on the routing sheet.

Note: At least one member and a PD? user must be added to the new template before saving it.

14. Click [OK] to save the new template and return to the Templates window.
15. Click the [Close] button to return to the user’s desktop.

Editing a Route Template

The PRweb user can edit existing route templates to add or remove users from the template.
To edit a route template:

1. From the menu, select Preferences > Route Templates.

The Templates window opens.

i Templates _ | O]
Mame | D'escription T New |
Adrnir, Adrministrators Ternplate ;
Testing Test Template Edit... |
[ElEte |
1 | = Cloze
|Warning: Applet wWindow

Figure 34: Templates Window

2. Highlight the route template to be edited.

Note:  For a quick way to search a list, refer to the ‘Searching Within A List” section in Chapter
2: PRweb Desktop.
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3. Click the [Edit] button.

Template - TEST [ x|

Mame: |TEST

D'ezcription: Itesters

View Boutees By : ¥ g
" Group

-

I on-tdembers tembers

ACH USER C
&CH USER D

ACQUSERE

ACQ USERF "=
ACQUILINE USERA,

ACQUSER B
ACQUSERTD

ACQUSER1O
AL GANZEMULLER
EAREARA E BROCK .

Foute to POE User: IS_I,Istem Adrmiristratar Calact . |

Wiew Gru:uups...l k. | Cancel I

|Warning: Applet window

Figure 35: Template - <Template Name> Window

4. Edit the template description in the Description field if necessary.

Note: The name in the Name field is not editable.

5. Select additional members for the template by highlighting desired users from the Non-
Members list box and clicking the [ p ] button.

Note: For a quick way to search a list, refer to the ‘Searching Within A List” section in Chapter
2: PRweb Desktop.

Note: The Non-Members list box displays all available users to add to the route template. As
users are added to the route template their usernames display in order in the Members
list box and are subsequently removed from the Non-Members list box. Members may
be removed from the route template by highlighting the desired user from the Members
list box and clicking the [ 4 ] button.

6. Select the Group radio button from the View Routees By field.
7. Edit the members from the Non-Members list if necessary.

8. Click [OK] to save the new template and return to the Templates window.
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9. Click the [Select] button next to the Route to PD? User field to change the PD? user.

The Select PD? User window opens.

Select PDZ Uszer

PO Jzer

Draminic J el

Sarah Jopce

System Adminigtrator

Gelect i Cancel

|Warning: Applet twindow

Figure 36: Select PD? User Window

10. Highlight the appropriate Contract Official.

11. Click the [Select] button.
The PD’ user selected displays in the Route to PD’ User field on the routing sheet.

Note: At least one member and a PD” user must be included on the template before saving it.

12. Click [OK] to save the changes and return to the Templates window.

13. Click the [Close] button to return to the user’s desktop.
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Deleting a Route Template

The PRweb user can delete existing route templates.
To delete a route template:

1. From the menu, select Preferences—> Route Templates.

The Templates window opens.

i Templatesz _ | O]
Name | D ESD”ptIDn ......... NEW ......... |
Adrir, Adminiztrators Temnplate :
Testing Test Template Edit..

| T = Cloze

|Warning: Applet WwWindow

Figure 37: Templates Window

2. Highlight the route template to be deleted.

Note: For a quick way to search a list, refer to the ‘Searching Within A List” section in Chapter
2: PRweb Desktop.

3. Click the [Delete] button.

The Confirmation window opens.

Confirmation E
@ ou are about o delete this route
ternplate. Would you like to continue?

: ........... l_f ES.\,I Nl:l

|Warning: Applet Windaw

Figure 38: Confirmation Window

4. Click the [Yes] button.
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Change E-mail Address

The Change E-mail Address feature allows the PRweb user to change their e-mail address as
defined in the contact information. The e-mail address denotes where all PRweb generated alerts
are sent.

To change your e-mail address:

1. From the menu, select Preferences—> Change E-mail Address.

The Update E-mail Address window opens.
Update E-mail Address

PEweb User

Current E-mail Address: Iiack_reynaldg@ams_cnm

Mew E-mail Address: ||

k. Cancel

|Warning: Applet window

Figure 39: Update E-mail Address Window

2. Enter the new e-mail address in the New E-mail Address field.

3. Click [OK] to save the changes.

Out of Office

The Out of Office feature allows the PRweb user to specify a date range that the user will be
away. The user can also specify another PRweb user that the “out of office” user’s workload will
be forwarded to while the “out of office” user is away. E-mail notification is sent to the “out of
office” user informing the user that a PR or PR Mod has been forwarded to the designated
alternate. Once the Last Day Out of Office passes, the user’s workload will not be forwarded to
the designated user.

To specify out of office information:

1. From the menu, select Preferences 2 Out of Office.

Out of Office window opens.
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Out of Office EI

[ Out of Office Activated

First Dray Out of Office: || éwl‘
Last Day Out of Office: | éwl‘
Fonwarding ‘Warkload to PRweb Lser: Select... |

ok | Cancel I

Warning: Applet Window

Figure 40: Out of Office Window

2. Select the Out of Office Activiated check box.

3. Enter the appropriate date in the First Day Out of Office field.
This is a required field.

4. Enter the appropriate date in the Last Day Out of Office field.
This is a required field.

Note: The First Day Out of Office and Last Day Out of Office dates can be entered manually
or by using the Auto-Calendar feature. For more information on the Auto-Calendar, refer
to “Auto-Calendar Feature” section in Chapter 2: PRweb Desktop.

5. Click the [Select] button next to the Forwarding Workload to PRweb User ficld.
The Select PRweb User window opens.

Select PRweb User

fvailable PRweh Users il

30 CHARACTERS USER ID
ACCEPTOR FOUR
ACCEPTOR OME
ACCEPTOR THREE
ACCEPTOR TWO

ADAM AMNDREWS
AMDREW
ACILAFIRA

Alex Schefer

B Watson

Select... Cancel

|Warning: Applet Windaw

Figure 41: Select PRweb User Window
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6. Highlight the user and click the [Select] button to select the desired user.
The selected user displays in the Out of Office window.

Out of Office x|

v Out of Office Activated

First D'ay Out of Office: IEI?;"EIEI;’EIE éwl‘

Last Day Out of Office: [07/22/02 éﬁ.:l

Formarding *orkload to PRweb User: ADAM ANDREWS Delete. . |
0k, | Cancel |

Warning: Applet Wwindow

Figure 42: Out of Office Window
7. Click [OK] to save the Out of Office configuration.

8. Click [Cancel] to cancel the Out of Office configuration.

To remove out of office information:

1.  From the menu, select Preferences 2 Out of Office.

Out of Office x|

¥ Out of Office Activated

First Day Out of Office; IEI?HEIEI.-’EIE éwl‘

Last Day Out of Office: [07/22/02 %"":I

Fonmarding *orkload to PRweb User: ADaM ANDREWS Delete. . |
0k | Cancel |

Warning: Applet Window

Figure 43: Out of Office Window

2. Clear the Out of Office Activated check box.

The First Day Out of Office, Last Day Out of Office, and Forwarding Workload to
PRweb User fields are cleared.
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Out of Office

r

Figure 44: Out of Office Window

3. Click [OK] to save the Out of Office configuration.

4. Click [Cancel] to cancel the Out of Office configuration.
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Chapter 4: Purchase Request

The Purchase Request (PR) document is the principle In This Chapter...

document supported within PRweb. The PRweb
module allows the requesting agent to create, route,
approve, and submit the PR to the Contracting Office.

Using the Purchase Request
functions described in this chapter,

The electronic interchange of the PR, and the ability of you can:
the requesting agent to track the status of the PR, e Create and Manage PRs
provides an integrated solution to support paperless .
acquisition. e Manage Funding Sources
e Manage Funding Strips
Creating a New Purchase Request e Manage Job Orders

To create a new Purchase Request:

1. From the menu, select Purchase Request > New.

i PRweb

(Er..

e BT AT,

[EamE.,

[Nelete

FR Statuz Repart...
Standard Reports. ..

Henumber..

Biaute:..

BOEIEYE..

wier Eppratial Hiskon.,

| acquzer]

|Warning: Applet Window

Figure 45: New Purchase Request Menu Option
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The PR Header displays at the top of the Purchase Request window and is visible from
every tab of the Purchase Request window.

' Purchasze Request - New [_ O] =]
File Line Item

Dezcription Purchasze Reguest Humber
Purchase | [
REqueSt Requigition D ate DFAS Priority Rating | Priority
|14-Gep-2000 | |

Figure 46: Purchase Request Header

Enter a description in the Description field.

The Purchase Request description allows the PRweb user to assign a descriptive reference of
up to 60 characters. This field is required to save a PR.

Enter a unique number in the Purchase Request Number field.

The Purchase Request number allows the PRweb user to assign a unique alphanumeric
combination of up to 30 characters to the PR. Duplicate PR numbers are not allowed. This
field is required to save a PR.

Enter the Defense Priority Allocation System (DPAS) Priority Rating in the DPAS Priority
Rating field.

This field holds up to 6 characters.

Enter the appropriate priority number in the Priority field.
This field holds any number between 1 and 15.

Note: The PRweb module automatically assigns a date/time stamp called the Requisition Date,

to the PR upon creation. This field is not editable.
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Main Form Tab

The Purchase Request opens to the Main Form tab. The Main Form tab contains information
regarding the Requesting Office, Issuing Office, Suggested Vendors, Type of Action and
Comments.

i Purchase Request - New ;IEIE'

File  Line Item

Drezcription
Purchase | [

Request

Purchaze Reguest Mumber

Fequizition D ate DPAS Prionity Rating | Priority
[ 25-Jun-2002 | |

Main Form | Line tem | Contracts | Add| Data |

Requesting Office Select || Type of Action
Meaisl COMMUMICATIONS DET. WaASHINGT | Small Purchase ™ Grants/Coops Agresment
¢ Competed Contract ¢ Sealed Bid
WASHINGTON, DC 20330 " Mon-Competed Contract ¢ F55/G54 Schedule
‘I I ﬂ ™ Manufacturer Sole Source © Commercial
IssLiing Office Delate I " Delivery Order " MIB #MISH / FPI
™ Task Order

/AL TER REED ARMY MEDICAL CEMTER «

DIRECTORATE OF COMTRACTING E t

ATTM: HSHLZC, BUILDING T-20 amments
|

40T FmmE

1]

3
Suggested YWendar(s] Add... |

\Warning: Applet MWindow

Figure 47: Purchase Request - New — Main Form Tab

1. Select the appropriate Type of Action radio button.

Note: The Requesting Office and Issuing Office fields default to the Requesting Office
defined in the creator’s user account on the Contacts tab.

2. Click the [Select] button next to the Requesting Office field.
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The Requesting Office Address Search window opens.

Requesting Office Addrezs Search E3

Search Criteria Search By

IE %' Code " Phone Mumber

" Organization " Zip Code
Search | (et | Cancel |  State
Code | Organization | Street City | State| £ip Eu:u:le| A

0| 3

|'W'arning: Applet Window

Figure 48: Requesting Office Address Search Window

3. Enter Search Criteria, and click the [Search] button.

Note: For more information regarding searches, refer to “Search Function” section in Chapter
2: PRweb Desktop.

4. Highlight the desired Requesting Office Address.

5. Click the [Select] button.
The Main Form tab displays with the selected Requesting Office in the Requesting Office
Address field.

6. Click the [Select] button next to the Issuing Office Address field.
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Izsuing Office Addrezs Search

The Issuing Office Address Search window opens.

Search Criteria Search By
IE = Code ™ Phone Mumber
" Organization " Zip Code
Search | Selewt | Cancel | € State
Code | Organization | Street | City | State| Zip Eu:n:lel A

M

|'W'arning: Applet \Wwindow

Figure 49: Issuing Office Address Search Window

7. Enter Search Criteria, and click the [Search] button.

Note: For more information regarding searches, refer to “Search Function” section in Chapter
2: PRweb Desktop.

8. Highlight the desired Issuing Office Address.

9. Click the [Select] button.
The Main Form tab displays with the selected Issuing Office in the Issuing Office
Address field.

10. Click the [Add] button next to the Suggested Vendor(s) field.

The Suggested Vendor(s) field allows the PRweb user to identify potential
suppliers/contractors for the request. Vendor information is pulled from the PD* database.
The PRweb module user cannot create new vendor profiles; the Contracting Office must do
this via PD’.
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The Vendor Address Search window opens.

Yendor Addrezs Search
Search Criteria Search By

IE f* Code ™ Phone Mumber

' Mame " Zip Code
Search | Selest | Cancel | € State
Code | Organization | Street | City | State| £ip Code | A

LI 3
|'W'arning: Applet "Window

Figure 50: Vendor Address Search Window

11. Enter Search Criteria, and click the [Search] button.

Note: For more information regarding searches, refer to “Search Function” section in Chapter
2: PRweb Desktop.

12. Highlight the desired Vendor Address.

13. Click the [Select] button.
The Main Form tab displays with the selected vendor(s) in the Suggested Vendor(s) field.

Note: The [Add] button becomes the [More] button after selecting one Suggested Vendor(s).

14. Enter comments about the requirement into the Comments field.

This field holds up to 255 characters.
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Additional Suggested Vendors

1. Click the [More] button next to the Suggested Vendor(s) field.

The Vendor Summary View window opens.

1 Vendor Summary Yiew

- [O) x|
Vendor Summary View

BN724 AMERICAN MANAGEMENT 4114 LEGAT! FAIRFAX Va 22033 703-227-555
182037705 BALL AEROSPACE 10LOMGS O BROOMFIELD CO

a0020-251

=l 3
.-’-'u:lu:ll Remove 0k Cancel
|Warning: Applet Window
Figure 51: Vendor Summary View Window
2. Click the [Add] button.
The Vendor Address Search window opens.
Yendor Addresz Search
Search Criteria Search By
IE & Code " Phone Mumber
= Mame " Zip Code
Search | Helent | Cancel | " State
Code | Organization | Street | City | State| £ip Eu:u:le| A
=l 3
|Warning: Applet \Window

Figure 52: Vendor Address Search Window
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3. Enter Search Criteria, and click the [Search] button.

Note: For more information regarding searches, refer to “Search Function” section in Chapter

2: PRweb Desktop.

4. Highlight the desired Vendor Address.
5. Click the [Select] button.

The Main Form tab displays with the selected vendor(s) in the Suggested Vendor(s) field.

Remove Suggested Vendor
1. Click the [More] button next to the Suggested Vendor(s) field.

The Vendor Summary View window opens.

1 ¥endor Summary Yiew M=l B3

Yendor Summary Yiew

BM724 AMERICAN MANAGEMENT 4114 LEGATI FAIRFAX VA 22033 703-227-555
182037705 BalLL AEROSPACE 10LONGS D BROOMFIELD CO  80020-251

| Remowve ok, Cancel

|Warning: Applet Window

Figure 53: Vendor Summary View Window

2. Highlight one or more vendors and click the [Remove] button.

3. Click [OK] to return to the Main Form tab.
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Line Item Tab

The Line Item tab of the PR provides a summary of the line items on the PR. This summary
provides general information on line items for a PR such as Number, Description, Quantity,
Unit of Issue, Unit Cost, and Total Cost.

In PRweb, funding may be handled at the contract level or at the line item level. Contract level
funding may be entered on the Line ltem tab. To establish line item level funding, the information
may be added on the Funding tab in the Line Item Detail window. To create a line item refer to
Chapter 6: Line Item.

& Purchase Request - PRO101 - |I:I|i|
File Line Iterm

Description Purchaze Reguest Mumber
Purchase | |unitorms {PRO101
Requeat Requistion Date DRAS Priority Rating | Priarity
|24-Jun-2002 E E
Main Form ~ Line ftem | Cortracts | Adcl| Data |
Total Funding: |$|:|_|:||:| Contract Level Funding  {FIE%0

* Valyes say e munded for oizalay purposes.

| Murnber ‘ Description | Cuantity | Unit af lzzue Unit Cost Tatal Cost *

Total Cost: | 50.00

|Java Applet \wWindow

Figure 54: Purchase Request - <Purchase Request Number> — Line Item Tab
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Creating a New Funding Source

PRweb users can create funding sources at the contract level. The System Administrator grants
user rights to manage funding information. If the user does not have these rights, funding
information is read-only or not available.

1. Click the [New] button next to Contract Level Funding.

The Contract Level Funding window opens.

Note: If associated funding information is already in the database, the [More] button displays
and the funding information displays in the table.

& contract Level Funding x|

Contract Level Funding

Funding Strip Funded Amoaourt

1 [ S
ey ... Edlit... Delete Cloze |

|.Ja\-'a Applet Window

Figure 55: Contract Level Funding Window

2. Click the [New] button to add funding information.
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The Funding Sources - New window opens with the funding header displayed at the top.

The funding header includes the Document Number and the Total Estimated Cost of all
line items.

fh,
A

Funding Sources - New

Figure 56: Funding Sources — New Window

3. To search for an existing funding strip, click the [Manage] button.

Acquiline PRweb v2.3 50 July 29, 2002
Functional User’s Guide



Chapter 4: Purchase Request

The Funding Strip Search window opens.

Funding Strip Search x|
Search Criteria: IE =2l B
* Code
ey, . | Ext... | Copy... | Delete " Lser 1D
Search I Select I Cancel I Template: IGIDhaI ll
Code | =zer |0
1| [+
Java Applet Window

Figure 57: Funding Strip Search Window

4. Select the appropriate template from the Template drop-down list box.

Note: Selecting “Global” in the Template drop-down list box searches across all templates.
5. Enter Search Criteria.

6. Click the [Search] button.
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The search results display.

Funding Strip Search x|
Search Criteria; IE Szl el Efy
' Code
Mesne.. | Ediit... | Copy... | Delete " Uzer ID
Template: I.&rm':.f ;I
Code Uzer D
3.;” 1 1 1 1 1 1 1 1 1 1 1 1 1 r'r'|'-,|'|,-';5|':|-'
21 EI‘-.-'I'I.-“-.I“I 2.&.&.&.&3445555CCCCCCCEE????BBDEEIEEIEI*I T 11 2222223F 38883 Py
1| [ r
Java applet \Window

Figure 58: Funding Strip Search Window

Note:  Only funding strips that have been created by the user or released by the PD* System
Administrator are displayed.

7. If the desired funding strip is not found skip to step 10. Ifit is found, continue with step 8.
8. Highlight the desired funding strip and click the [Select] button.

9. Skip to step 14.

Note:  For more information on searches, refer to “Search Function” section in Chapter 2:
PRweb Desktop.

10. If the funding strip is not found, click the [New] button.
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The <Default Template> Funding Strip — New window opens.

Army Funding Strip - New x|

Fund Strip

Departrment Codel2) Fizcal ¥eari1)

AppropriationBasic Symbol(4) Litnitation4)

Prograrm Year(1) Operating Agency(2)

Allotrment Serial Mumber( 41 Prograrm Element(11]

Element of Resource(4) MOEPSSODPIE]

Document Reference Mumber(1 41 Accounting Processing Code(B)

Fiscal Station Murnber(E) Las=t Digit(1)

Select Template:  Srmy - I OH | Close

Java Applet wWindow

Figure 59: Army Funding Strip — New Window

Note: The default funding strip template set by the System Administrator displays. If the
System Administrator has not selected a default template, you cannot continue

11. To change to an alternate template, select another template from the Select Template drop-
down list box.

12. Enter the funding strip information in the appropriate fields.

Note:  Each field must either be filled out completely or left blank.

13. Click [OK].

The funding strip displays on the list of available funding strips in the Funding Strip
Search window.

14. Highlight the new funding strip and click the [Select] button to select the new funding strip.

15. Enter the appropriate fund amount in the Funded Amount field.

The Funded Amount field allows the PRweb user to enter the desired dollar amount to
correspond with the selected funding strip. (It is not required to enter a dollar sign.)

Note: The Funded Amount defaults to the total cost of all line items.

16. Enter an Accounting Classification Reference Number (ACRN) in the Fund ACRN.

The Fund ACRN field allows users to enter ACRN information in the Funding Source
window. This field holds up to two characters.

17. Click [OK] to return to the Contract Level Funding window.
18. Click [Close] to return to the Purchase Request window.

19. From the menu, select File — Save to update the funding information and save the PR.
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Editing a Funding Source

PRweb users can edit funding sources at the contract level. The System Administrator grants user

rights to manage funding information. If the user does not have these rights, funding information
is read-only.

@ Purchase Request - PRO101 -10O] x|
File Line Iterm

Description Purchasze Reguest Mumber
Purchase | |uritorms |PRO1D1
Requeat Requistion Date DPAS Pricrity Rating | Priority
| 24-Jun-2002 B B
Mazin Form  Line Rem | Cortracts | &dd| Data |
Total Funding: |$1D,DDD.DD Contract Level Funding

* Faluwes may be murded for disolay ouposes.

|| tmbor [ pesoriptn | Quantty | unitotissue|  umtCost | Tofalcost: | |

Total Cost:  |50.00

|-_Ia\-'a Applet wWindow

Figure 60: Purchase Request - <Purchase Request Number> - Line Item Tab

1. From the Line Item Tab of the Purchase Request window, click the [More] button next to
Contract Level Funding.

The Contract Level Funding window opens.
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& rcontract Level Funding |

Contract Level Funding

Funding Strigp Funded Amovnt

21 201 44655 F77Ea0ES9991 1111111111112 FIZT 10,000.00

Mewy ... ........ Edit.. Delete Close |

IJa\-'a Applet Window

Figure 61: Contract Level Funding Window

2. Highlight the funding source to be edited and click the [Edit] button.

The Funding Sources window opens.

& Funding Sources |

Funding Sources

Document Number IPRIII1 01
Total Estimated Cost: I:BD.EIEI

Fund Strip New.. | Edt.. | Manage..|

21200AN 28008 34485530 CCCCCCES T FFSEDESSIIN TN 1N 1111111 222222 FFFF A TS

Funded Amount: |$1 0,000,00 Fund ACRMN: |23

Job Order | Expiration Date | Quatity ‘ Funded Smourt Add... |

Ediit...

Tatal Cuantity: IIZI.IZI Total Amount. (000 Delete |

Ok | Cancel |

|Java Applet wWindow

Figure 62: Funding Sources Window

3. Make desired changes and click [OK] to return to the Contract Level Funding window.
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4. Click [Close] to return to the Purchase Request window.

5. From the menu, select File & Save to update the funding information and save the PR.

Deleting a Funding Source

PRweb users can delete funding sources at the contract level. Deleting a funding source removes
it from the PR. The System Administrator grants user rights to manage funding information. If
the user does not have these rights, funding information is read-only.

& Purchase Request - PRO101 ;Iglil

File Line Iterm

Dezcription Purchaze Reguest Mumber
Purchase  |uniforms {PrRO101
REqUESt Reguizition Date DPAS Priority Rating | Priority
J24-Jun-zo02 E 3

Msin Forrn  Line Kem | Contracts | Add Data

Total Funding: |$1U.UUU-UU Contract Level Funding Mure...l

* Yalyes may pe munded for dis0l3y guiposes.

| Murnber | Description | Gwaritity ‘ Unit af lzsue Unit Cost | Tatal Caost *

Total Cost:  |F0.00

|-_Ia\-'a Applet Window

Figure 63: Purchase Request - <Purchase Request Number> — Line Item Tab

1. From the Line Item tab of the Purchase Request window, click the [More] button next to
Contract Level Funding.

The Contract Level Funding window opens.
2. Highlight the funding source to be deleted and click the [Delete] button.

3. Click the [Yes] button in the Confirmation window.

The Contract Level Funding window displays with the funding source deleted from the
table.

4. Click the [Close] button to return to the Purchase Request window.

5. From the menu, select File & Save to update the funding information and save the PR.
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Creating a New Funding Strip

PRweb users can create funding strips at the contract level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information
is read-only.

i Purchaze Request - PRO100 M=] E3
File  Line Item
D ezcription Purchaze Reguest Mumber
Purchase  [Supplies [PROT00
REqUESt R equizition D ate DPAS Prionty Rating | Prionty
J07-Jun-2002 |

Msin Form  Line kem | Contracts | Addl Data

Total Funding: | Contract Level Funding MNew. |
¥ lfalyes i3y he munded for disnlay auposes.
Mumber | Dezcription Cluantity | Uit of lzzue rit Ciozt | Total Cost *
Total Cost: I

|Warning: Applet Window

Figure 64: Purchase Request - <Purchase Request Number> - Line Item Tab

1. Click the [New] button next to Contract Level Funding.
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The Contract Level Funding window opens.

Contract Level Funding
Contract Level Funding
Funding Strip Funded Amount
5| 3
MNew... | it [ElEte Cloze |

|'W'arning: Applet wWindow

Figure 65: Contract Level Funding Window

2. Click the [New] button.

The Funding Sources — New window opens.
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Funding Sources - New

Funding Sources

Document Mumber |

Tatal E ztirmated Cozt:

Fund Strip MHew. Manage. ..

Funded Amount: |$0.00 Fund ACFM:

Job Order | Expiration Drate | [Cluantity | Furnded Amount Add.. |

Tokal Cuattity: T otal Amount: |

OF. | Cancel |

Warking: Spplet Window

Figure 66: Funding Sources — New Window

3. Click the [New] button.
The <Default Template> Funding Strip - New window opens.

Army Funding Strip - New

Fund Strip

|
Department Codel(2) ’— Fizcal ear(1] ’—
AppropriationsB asic Symboal(4) ’— Lirnitation[4] ’—
Program Year(1] l— Dperating Agency(2) l—
Allatment Serial Murmber(4) ’— Progrann Element(11) ’—
Element of Besource(4] ’— MDEP/SODPE) ’—
Document Reference Number(14) ’— Accounting Processing Code(5) ’—
Fiscal Station Murnber(B) l—

Select Template: Army j (0] | Cloze |

WWarhing: Applet Window

Figure 67: Army Funding Strip — New Window

4. To change an alternate template, select another template from the Select Template drop-
down list box.
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5. Enter the funding strip information in the appropriate fields.

Note: Each field must either be filled out completely or left blank. However some fields may
be required, depending on how the System Administrator configured the funding
template.

S

Click [OK].
The funding strip displays in the Fund Strip field of the Funding Sources - New window.

7. Click [OK] to return to the Contract Level Funding window.
8. Click [Close] to return to the Purchase Request window.

9. From the menu, select File — Save to update the funding information and save the PR.

Note: A new funding strip may also be created from the Funding Strip Search window by
clicking the [New] button.
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Copying a Funding Strip

PRweb users can copy funding strips at the contract level. Copying funding strips may save time
in the creation of new funding strips. The System Administrator grants user rights to manage
funding information. If the user does not have these rights, funding information is read-only.

& Purchase Request - PROLOO Y m]

File Line Iterm

Dezcription Purchaze Reguest Mumber
Purchase | [suppiie: JPrRO100
REqUESt Reguizition Date DPAS Priority Rating | Priority
Jo7-Jun-zo02 |2 f1
Main Form ~ Line tem | Contracts | Add| Data |
Total Funding: |$1U.UUU-UU Contract Level Funding

* Yalyes may pe munded for dis0l3y guiposes.

| |umber [ oesorpton | ouantty | unorissue]  untcost | totacost | |

Total Cost:  |F0.00

|-_Ia\-'a Applet Window

Figure 68: Purchase Request - <Purchase Request Number> - Line Item Tab

1. Click the [More] button next to Contract Level Funding.
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The Contract Level Funding window opens.

£ contract Level Funding x|

Contract Level Funding

Funding Strigp Funded Amoaunt

1]

e Ediit.... Delete Close |

|Java Applet Window

Figure 69: Contract Level Funding Window
2. Click the [New] button.

The Funding Sources — New window opens.

Funding Sources - Hew E3

Funding Sources

Daocument Mumber IF'HEI‘I i

Tatal E stimated Cost: |$D.DD

Fund Strip MHew... I Edit,.. Manage...l

Funded Amount: |$EI.EIEI Fund ACRM: I

Job Order | Expiration D ate | Cluantity | Funded Amount Add. .. |

Edit... |

Total Quantiby: I T atal Armaount: I

[Elete |

(] | Cancel |

|'W'arning: Applet wWindow

Figure 70: Funding Sources — New Window
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3. Click the [Manage] button.

The Funding Strip Search window opens.

Funding Strip Search
Search Criteria; Iﬂ Search By
% Code
Mew... I it I (B I [Ielete I " User ID
Search I Selest I Cancel I Template: IGIDI:uaI ;I
Code | zer D

[T

|Warning: Applet Window

Figure 71: Funding Strip Search Window

4. Select the appropriate template from the Template drop-down list box.
5. Enter Search Criteria, and click the [Search] button.
Note:  For more information regarding searches, refer to the “Search Function” section in

Chapter 2: PRweb Desktop.
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Funding Strip Search x|
Search Criteria; IE Search By
* Code
M. .. | Ecit... | Copy... | Delete " User ID
Search I Select I Cancel I Template: I.&rm\y' j
Code =zer |0

1| Ir

Java Applet Window

Figure 72: Funding Strip Search Window

6. Highlight the desired funding strip and click the [Copy] button.

The <Default Template> Funding Strip - Copy window opens with the copied funding
strip information in each field.

Army Funding Strip - Copy ﬁl
Fund Strip
089897559447 7944445944455t gyh4 5457 8599r85554 444444444537 5948999938
Departrient Code(2) |33 Fizcal Year(1) |9
AppropristionBasic Syrmbali4) |39?3 Litnitation(4) |3944
Prograrm Yeari1) |? Operating Agency(2) |?9
Allotrment Serial Mumber(4) |4444 Prograrn Elementr 117 |3g44455tggh
Element of Resourceld) |4545 MDERISCDPIE) |?8899r
Document Reference Mumber(14) |33334444444444 Accounting Processing CodelE) |393394
Fiscal Station Mumber(B) Igggggg Last Digit(1) |3

Select Template: 2rmy VI Ok | Cloze

Java Applet window

Figure 73: Army Funding Strip — Copy Window

Note: The funding strip is copied into the template that corresponds with the PRweb template
used to create the original funding strip. If the funding strip was created with a PRweb
template that has either been disabled or updated, the PRweb user is unable to copy the
funding strip. In addition, funding strips that were created in PD* will display as
Miscellaneous.
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7. Make the desired changes to the funding strip.
8. Click [OK] to save the changes and return to the Funding Strip Search window.
The new funding strip displays in the Funding Strip Search window.

9. Highlight the funding strip and click the [Select] button to select the new funding strip.
10. Click [OK] to return to the Contract Level Funding window.
11. Click [Close] to return to the Purchase Request window.

12. From the menu, select File > Save to update the funding information and save the PR.
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Editing a Funding Strip

PRweb users have two options for editing funding strips at the contract level. The System
Administrator grants user rights to manage funding information. If the user does not have these
rights, funding information is read-only.

If the System Administrator has updated or removed the template from which the selected funding
strip was created from, PRweb alerts the user that the template has changed.

@ The funding template uszed to create this
funding strip haz been changed or dizabled.
Select Vet to update uzing new funding

terplate. Select Mo'to view zelected
funding stip az read only.

Tes | Mo

|Warning: Applet Window

Figure 74: Confirmation Window

If the user selects [Yes], PRweb displays the updated version of the template or the default
template, depending on whether the template was disabled. The user is able to select another
template if desired from the Select Template dropdown list box.

Army Funding Strip - Hew

Fund Strip

D epartment Code(2]

Fizcal Year(1]

Appropriation/Bazic Symbal(4] Lirnitation] 4]

Program 'ear(1] Operating Agency(2)

Allotrment Serial Mumber[4] Program Element{11]

MDER/SODF(E)

Element of Rezourceld]

Document Feference Mumber(14) Accounting Proceszing Code(F)

Fizcal Station Murmber[B] Lazt Digit[1]
Select Template: Ay 'I (u] 4 I Cloze

|W’arning: Applet Window

Figure 75: Army Funding Strip — New Window

AcquiLine PRweb v2.3 66 July 29, 2002
Functional User’s Guide



Chapter 4: Purchase Request

If the user selects [No], the funding strip displays as read-only.

Army Funding Strip - [Read Only] [ x|

Fund Strip

|881 124812223041 118PRET 230035970 3334B 3085 PO40026G 09345556 780542334

Department Code(2) Igg Fizzal Year(1] |1

Appropriation/B asic Symbaol[4] |1 ) Limnitation(4] |1 299

Program “'ear(1] |3 Operating Agency(2] IDA

Allatment Serial Murnber(4) |1 118 Program Element(11] IPHE1 2300997

Element of Resource(4) |MW’33 MDEF/SODP(E) |34Egng

Document Reference Number(14] ISPD4UU2SGDQ345 Accounting Processing CodefB] |558?85

Fizzal Station Mumber(E) |5g2334

Select Template: &y - I 1] | Close

|\ arning: &pplet window

Figure 76: Army Funding Strip — (Read Only) Window

Option 1: By Funding Strip Search

& Purchase Request - PRO1OO ) ] [
File Line Item

Dezcription Purchaze Reguest Mumber
Purchase | [=.pie- Jpra100
RequeSt Requizition Date DPAS Priority Rating | Priarity
J07-Jun-2002 |2 1

Main Form ~ Line kem | Contracts | Add| Data

Total Funding: |$1D,DDD.DD Contract Level Funding Mure...l

* alwes may he munded fordisplay puvposes.

| Murnker | Description | Guaritity ‘ Unit of lzsue Unit Cost | Total Cost * |

Total Cost:  |50.00

IJava Applet \Window

Figure 77: Purchase Request - <Purchase Request Number> - Line Item Tab
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1. Click the [More] button next to Contract Level Funding.

The Contract Level Funding window opens.

% Contract Level Funding : |

Contract Level Funding

Funding Strig Funded Amaunt
212000 2888 0 2 44BESSERCCCCCCESETTEEDEISSI 11111 11111111 222222323F 883 10,000.00

1| [IE

e Edit.... Delete Cloze |

IJava Applet wWindow

Figure 78: Contract Level Funding Window

2. Highlight the desired funding source and click the [Edit] button.

Note: The PRweb user can also double-click on the funding source to open the highlighted
funding source.
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The Funding Sources window opens.

Figure 79: Funding Sources Window

3. Click the [Manage] button.
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The Funding Strip Search window opens.

Funding 5trip Search
S earch Criteria: IE Search By
& Code
Mew... | Edit... | [Eap. | [elete | " User ID
Search | SElEk | Cancel | Ternplate: |I3I|:|I:|a| ;l
Code | ger D
= v

|'W'arning: Applet \windom

Figure 80: Army Funding Strip — Edit Window

4. Enter Search Criteria, and click the [Search] button.

Note:  For more information regarding searches, refer to the ‘Search Function” section in
Chapter 2: PRweb Desktop.

5. Highlight the desired funding strip and click the [Edit] button.
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The Army Funding Strip — Edit window opens with the original funding information
displayed.

Note: You may not edit a funding strip that is applied to either another PR or another funding
source on the same PR.

Army Funding Strip - Edit x|
Fund Strip
21 2h1 288 A8 3448555660 CCCCCEEET 7EE0DES89 11 1111111111 11 222222323F 555
Department Code(2) |21 Fizcal Year(1) Iz
AppropristionBasic Symbol(4) Imum 2 Lirnitation(4] I,a_,a\,.r_\g
Programm Year(1) |3 Operating Sgency(2) |44
Allotrment Serial Mumber; 43 |EISSS Prograrm Element(111 |55cccccc533
Elemert of Resourceld) I??aa MOEPYSCODP(E) IDEEIEIEIEI
Document Reference Mumber(1 43 |1 1111111111111 Accounting Processing Code(B) |222222
Fizcal Station Mumber(6) |323F33 Last Digit(1) |3

Select Template: Sy ht I Ok | Close

Java Applet wWindow

Figure 81: Army Funding Strip — Edit Window

6. Make desired changes to the funding strip and click [OK] to return to the Funding Strip
Search window.

7. Click the [Select] button to select the updated funding strip and return to the Funding
Sources window.

8. Click [OK] to return to the Contract Level Funding window.
9. Click the [Close] button to return to the Purchase Request window.

10. From the menu, select File — Save to update the funding information and save the PR.
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Option 2: By Funding Sources Window

& Purchase Request - PRO100 ;Iglil
File Line Iterm

Dezcription Purchaze Reguest Mumber
Purchase | [s.pie- Jpra100
Requeat Requisition Date DPAS Priority Rating | Priarity
J07-Jun-2002 |2 [
Main Form ~ Line item | Cnntractsl Add! Datal
Total Funding: |$1U.UUU-UU Contract Level Funding Mure...l

* alyes i3y pe munded for dis0!3y puposes.

| |umbor [oosorpton | ouantty | untorisue]  untcost | totacost | |

Total Cost: [$0.00

|-_|ava Applet \Windaw

Figure 82: Purchase Request - <Purchase Request Number> - Line Item Tab

1. Click the [More] button next to Contract Level Funding.
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The Contract Level Funding window opens.

£ contract Level Funding x|

Contract Level Funding

Funding Strigp Funded Amoaunt

911111111111111 10,000.00

1| [+

e Eciit.... Delete Close |

|Java Applet Window

Figure 83: Contract Level Funding Window

2. Highlight the desired funding source and click the [Edit] button.
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The Funding Sources window opens.

& Funding Sources x|

Funding Sources

Document Mumkber |F‘RD1 oo

Total Estimated Cost: |$I:I.EIEI

Fund Strip My I Edit. . Ir-.ﬂanage___l
2120 288 8 A ZAABSESRECCCOCCEEETTEE0DEAI0ST 1111111111111 222222 325F 553

Funded Amaunt: |$1EI,I:II:II:I.DEI Fund &CREM: I

Jaob Crder | Expiration Date | Cuantity | Funded Armaount Addd.. |

Ediit....

Total Quantity: II:I.I:I Total Amount:  |0.00 Delete |

Ok | Cancel |

|-_|a\-'a Applet wWindow

Figure 84: Funding Sources Window

3. From the Funding Sources window click the [Edit] button next to the Fund Strip field.

The Funding Strip — Edit window opens with the original funding information displayed.

Army Funding Strip - Edit 5'
Fund Strip
21204 242243448 55566CCCCCCEEETTEEDESA9 111111111 1111 222222323F 853
Depattment Codel2) |21 Fizcal Year(1) |2
AppropristionBasic Symbol(4) |Mw1 2 Litvitation;4) |,.v_~.,,a\,.r_\.,g
Progratn Year(1) |3 Operating Agency(2) |44
Allattnert Serial Number(4) |EISSS Progratn Element(117 |EECCCCCC588
Eletriert of Resource(d) I??BB MOEPISCDPE) |DE9999
Document Reference Mumber(1 4] |1 1111114111111 Accounting Processing Code(B) |222222
Fizzal Station Mumber(6) |323F33 Last Digit(1) |3

Select Template: Sy x I Ok | Claze

Java dpplet Window

Figure 85: Army Funding Strip — Edit Window
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4. Make desired changes to the funding strip and click [OK] to return to the Funding Sources
window.

5. Click [OK] to return to the Contract Level Funding window.
6. Click the [Close] button to return to the Purchase Request window.

7. From the menu, select File> Save to update the funding information and save the PR.

Deleting a Funding Strip

PRweb users can delete funding strips at the contract level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information
is read-only.

& Purchase Request - PRO101 ;lglil
File Line ltem

Dezcription Purchaze Reguest Mumber
Purchase  [uniforms {PrRO101
Requesi: Requiztion Date DPAS Priority Rating | Priarity
J24-Jun-zom2 |3 3
Main Form ~ Line tem | Cotracts | Add| Data |
Total Funding: |$1DIDDD_DD Contract Level Funding Mure...l

* Yzlues @y he munded for disolFy gurposes.

| Murnber | Description | Cantity ‘ Unit af lzsue Lnit Cost | Tatal Caost * |

Total Cost:  |$0.00

|Java Applet \Window

Figure 86: Purchase Request - <Purchase Request Number> Window

1. Click the [More] button next to Contract Level Funding.
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The Contract Level Funding window opens.

£ contract Level Funding x|

Contract Level Funding

Funding Strigp Funded Amoaunt

7 TEE0EIISS1 1111111111112 3 10,000.00

Delete Close |

e

|Java Applet Window

Figure 87: Contract Level Funding Window

2. Highlight the desired funding source and click the [Edit] button.
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The Funding Sources window opens.

& Funding Sources ﬂ

Funding Sources

Document Mumkber |F‘RD1 01
Total Estimated Cost: |$I:I.EIEI

Fund Strip My I Edit. . Ir-.ﬂanage___l
|21 2R 28,8 8 0 3RS SCCCCCOCEET T T FEEDESAA 1 N 111 1 1112222227 FFF T 73

Funded Amaunt: |$1EI,I:II:II:I.DEI Fund &CREM: I
Add... |

Ediit....

Total Quantity: II:I.I:I Total Amount:  |0.00 Delete |

Ok | Cancel |

|-_|a\-'a Applet wWindow

Figure 88: Funding Sources Window

3. Click the [Manage] button.
The Funding Strip Search window opens.

4. Enter Search Criteria, and click the [Search] button.

Note: For more information regarding searches, refer to the “Search Function” section in
Chapter 2: PRweb Desktop.
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Funding Strip Search x|
Search Criteria; IE SIEEIER B
& Code
ey . | Edit... | Copy... | Dielete " User D
Search | Select | Cancel | Template: I.ﬂ-.rﬂ'l':." ;I
Codle | U=et D
2120000 200 00 344 RSSSEECCCCCCERATTEEDES 1111111 111111 2222223 23F883 Py

212001 2.&.&.&.&344BSSSCCCCCCCEB????BBDEEIEEIEI*I 111111111111 EEEEEESFBBBBS HrsneEy

21 2hiiny 2 4455 FF77EaDEI9991111M111111111

1| [r

Java applet \Window

Figure 89: Funding Strip Search Window

5. Highlight the desired funding strip and click the [Delete] button.

Note:  You may not delete a funding strip that is applied to either another PR or another funding
source on the same PR.

6. Click the [Yes] button in the Confirmation window.

The Funding Strip Search window displays with the funding strip deleted from the table.
7. Click the [Cancel] button to return to the Funding Sources — New window.
8. Click [OK] to return to the Contract Level Funding window.
9. Click the [Close] button to return to the Purchase Request window.

10. From the menu, select File — Save to update the funding information and save the PR.
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Creating a Job Order

PRweb users can create job orders at the contract level. The System Administrator grants a user
rights to manage funding information. If the user does not have these rights, funding and job order

information is read-only.

& Purchase Request - PRO101 Y m]
File Line ltem

Purchaze Reguest Mumber

Dezcription
Purchase fUniforms {PrRO101
Request | . onDate DPAS Priority Reting | Priority
J24-Jun-zo02 E 3

Msin Forrn  Line Kem | Cortracts | Add| Data |

Total Funding: |$|:|,|:||:| Contract Level Funding  Mew...

* Yalyes may pe munded for dis0l3y guiposes.

| |umber [ oesorpton | ouantty | unorissue]  untcost | totacost | |

Total Cost:  |F0.00

|-_Ia\-'a Applet Window

Figure 90: Purchase Request - <Purchase Request Number> Line Item Tab

1. Click the [New] button next to Contract Level Funding.
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The Contract Level Funding window opens.

£ contract Level Funding x|

Contract Level Funding

Funding Strigp Funded Amoaunt

1| [+

e Ediit.... Delete Close |

|Java Applet Window

Figure 91: Contract Level Funding Window

2. Click the [New] button.
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The Funding Sources — New window opens.

E"_, Funding Sources - New

Figure 92: Funding Sources — New Window

3. Click the [Add] button next to the Job Order table.
The Attach Job Order — New window opens.

Figure 93: Attach Job Order — New Window

4. Click the [Select] button.
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The Job Order Number Search window opens.

Job Order Mumber Search

Search Criteria

IE W Current Job Orders Only
Search | melect Cancel
Job Order Mumber Fundz Expiration Date
Java applet \Window

Figure 94: Job Order Number Search Window

5. Click the [New] button.

The Create New Job Order window opens.

& Create New Job Order x|

Job Order Mumbet: I

Funds Expiration Date: I

Ok | Cancel

Jawa Applet Window

Figure 95: Create New Job Order Window

6. Enter a number in the Job Order Number ficld and an expiration date in the Funds

Expiration Date field.

Note: The funds expiration date can be entered manually or by using the Auto-Calendar feature.
For more information on the Auto-Calendar, refer to “Auto-Calendar Feature” section in

Chapter 2: PRweb Desktop.

7. Click [OK] to return to the Job Order Number Search window.

8. Double-click the new job order to return to the Attach Job Order window.

9. Click [OK] to return to the Funding Sources — New window.

The job order displays in the Funding Sources — New window.
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10. Click [OK] to return to the Contract Level Funding window.

11. From the menu, select File - Save to update the job order information and save the PR.

Attaching a Job Order

PRweb users can attach job orders at the contract level. The System Administrator grants a user
rights to manage funding information. If the user does not have these rights, funding and job order

information is read-only.

% Purchase Request - PRO101 ) ] [

File Linge ltem

Purchaze Reguest Mumber

Dezcription
{PrROT01

Purchase | [unitorms

RequeSt Requizition Date
J24-Jun-2002

DPAS Priority Rating | Priarity
E E

Main Form ~ Line kem | Cuntractsl Add| Data

Contract Level Funding  Rew... |

* alwes may he munded fordisplay puvposes.

Total Funding: |$n.nn

| Murnker | Description | Guaritity ‘ Unit of lzsue Unit Cost | Total Cost *

Total Cost:  |50.00

IJava Applet \Window

Figure 96: Purchase Request - <Purchase Request Number> Line Item Tab

1. Click the [New] button next to Contract Level Funding.

The Contract Level Funding window opens.

2. Click the [New] button.
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The Funding Sources — New window opens.

& Funding Sources - New x|

Funding Sources

Document Mumber |F‘REI1 01
Total Estimated Cost: |$EI.EIEI

Fund Ztrip Mlews. | it Manage_._l

Funded Amount: |$EI.I:IEI Fund ACRR: I

Job Qrdder | Expiration Date | Cuartity | Funded Atnaurt Add... |

Edlit...

Total Quartity: | Tatal Amaunt: | Dielete |

[8]1 | Cancel |
|Java Applet Window
Figure 97: Funding Sources — New Window
3. Click the [Add] button next to the Job Order table.
The Attach Job Order — New window opens.
Attach Job Order - Hew

Job Order; I
Funded Amount: 000000

Funded Quartity: IN;’.-’-‘-.

k. Cancel

|Warning: Applet window

Figure 98: Attach Job Order — New Window

4. Click the [Select] button.

AcquiLine PRweb v2.3 84 July 29, 2002
Functional User’s Guide



Chapter 4: Purchase Request

The Job Order Number Search window opens.

Job Order Number Search x|
Search Criteria
IE W Current Job Orders Only
Search | melect Cancel
Job Order Mumber Fundz Expiration Date
Java applet \Window

Figure 99: Job Order Number Search Window

5. Enter Search Criteria, and click the [Search] button.

The search results display.

Job Order Number Search x|
Search Criteria
IE [+ Currert Job Orders Only
Memwy. .. | Search Select Cancel |
Job Order Mumber Funds Expiration Date j
R 28-Jun-2003
Rl J IO 15-Jun-2004

10-Feh-2019

01-Sep-2003
30-Sep-2002

MO0123 12-May-2009

MhAPOO0T 12-May-2201

MrAPOO0T 11 -May-2201

ilzkil 27-Jun-2002 B

1| [ r
Java applet \Window

Figure 100: Job Order Number Search Window

6. Highlight the desired job order number and click the [Select] button.
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The Attach Job Order - New window opens.

& Attach Job Order - New

Jab Order: |wrnm:|33993

Funced Amourt: ||:|.|:u:|nn|:|

Funded Quartity: |NIA

Ok Cancel

|Java Applet "Window

Figure 101: Attach Job Order — New Window

7. Click [OK] to return to the Funding Sources - New window.
8. Click [OK] to return to the Contract Level Funding window.

9. From the menu, select File & Save to update the job order information and save the PR.
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Editing a Job Order

PRweb users can edit job orders at the contract level. The System Administrator grants a user

rights to manage funding information. If the user does not have these rights, funding and job order
information is read-only.

& Purchase Request - PRO101

=10 x|
File Line lterm
Description Purchaze Reguest Mumber
Purchase | |unitorms |PRO101
REqUESt Requisition Date DPAS Pricrity Rating | Priority
[ 24-Jun-z002 |3 3
Msin Form  Line tem | Cu:untractsl A Data
Total Funding: |$1EI,IZIEID.EID Contract Level Funding More...l

* alyes aay e munded for oisolay purposes.

Unit Cost
40,00

Murnber Dezcription Guantity

Unit af Izzue

oo

Total Cost *
$10,000.00

Unifarm Shirt

Total Cost:  |'510,000.00

|Java Applet wWindow

Figure 102: Purchase Request - <Purchase Request Number> Line Item Tab

1. Click the [More] button next to Contract Level Funding.
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The Contract Level Funding window opens.

& Contract Level Funding x|
Contract Level Funding
Funding Strip Funded Amoaourt
2120000 28NN ZAARSSSEECCCCCCREETTIEDESS9S I 1 111111111111 22222232 3F 853 10,000.00
1 [+
ey ... Edlt... [relete Cloze |

|-_|a\-'a Applet wWindow

Figure 103: Contract Level Funding Window

2. Highlight an existing funding source and click the [Edit] button.
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The Funding Sources window opens.

& Funding Sources ﬂ

Funding Sources

Document Mumkber |F‘RD1 01

Total Estimated Cost: |$1 0,000.00

Fund Strip My I Edit. . Ir-.ﬂanage___l
|21 2R 288 8 0 3 ABSSSERCCCCCCEEETTEEDESA991 1111111111111 222222325583

Funded Amount: II:I.I:IIZI Fund ACRMN: I

hIAD0S5995 01-Sep-2003

Ediit....

Total Quantity: II:I.I:I Total Amount:  |0.00 Delete |

Ok | Cancel |

|-_|a\-'a Applet wWindow

Figure 104: Funding Sources Window

3. Highlight the desired job order and click the [Edit] button next to the Job Order table.
The Attach Job Order - <Job Order Name> window opens.

& Attach Job Order - MWDO88993

Jok Order: meinozaa93

Funded Amourt:  |0.00

Funded Guantity; |N.r.-'3-.

Ok Cancel

|Java Applet Window

Figure 105: Attach Job Order - <Job Order Name> Window

4. Click the [Select] button.
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The Job Order Number Search window opens.

Job Order Number Search x|
Search Criteria
IE W Current Job Orders Only
e | Search melect Cancel
Job Order Mumber Fundz Expiration Date
Java applet \Window

Figure 106: Job Order Number Search Window

5. Enter Search Criteria, and click the [Search] button.

6. Highlight a job order number and click the [Select] button.

The Attach Job Order - <Job Order Name> window opens with the new job order
number displayed in the Job Order field.

& Attach Job Order - MWD038993

Jab Order: |cnnsag?9

Funced Amourt: ||:|.|:u:|

Funded Quartity: |NIA

Ok Cancel

|Java Applet "Window

Figure 107: Attach Job Order - <Job Order Name> Window

7. Click [OK] to return to the Funding Sources window.
8. Click [OK] to return to the Contract Level Funding window.

9. From the menu, select File =& Save to update the job order information and save the PR.
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Deleting a Job Order

PRweb users can delete job orders at the contract level. The System Administrator grants a user

rights to manage funding information. If the user does not have these rights, funding and job order
information is read-only.

% Purchase Request - PRO101 Y m]

File Line ltem
Dezcription Purchaze Reguest Mumber

Purchase | [Lriiorn: JerO101
REqUESt Reguizition Date DPAS Priority Rating | Priority
J24-Jun-zo02 E 3
Main Form ~ Line tem | Contracts | Add| Data
Total Funding: |$1 0,000.00 Contract Level Funding  Mare... |

* Yalyes may pe munded for dis0l3y guiposes.

Murnber

oo

Description

Gwaritity

Unit af lzsue Unit Cost

40.00

Total Cost *
$10,000.00

Uniform Shirt

Total Cost:  |$10,000.00

|-_Ia\-'a Applet Window

Figure 108: Purchase Request - <Purchase Request Number> Line Item Tab

1. Click the [More] button next to Contract Level Funding.
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The Contract Level Funding window opens.

& contract Level Funding x|

Contract Level Funding

Funding Strip Funded Amoaourt

999911111111111111 53 10,000.00

1 [ S
ey ... Eclit... Delete Cloze |

|-_|a\-'a Applet wWindow

Figure 109: Contract Level Funding Window

2. Highlight an existing funding source and click the [Edit] button.
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The Funding Sources window opens.

£ Funding Sources x|

Funding Sources

Document Mumber |F‘REI1 01
Total Estimated Cost: |$1 0,000.00

Fund Ztrip Mlews. | Eciit .. Manage_._l
212000 2800 0 344 RSSSEECCCOCCEIET TEEDEAA981 1111111111111 22222232 3F 553

Funded Amount: II:I.DEI Fund ACRR: I

Job Qrdder Expiration Date Cuartity Funded Atnaurt Add...

PSSR 28-Jun-2003

Eddit...

Tatal Quantity: II:I.D Total Amount:  |0.00 Delete |

Ok | Cancel |

|Java Applet Window

Figure 110: Funding Sources Window

Highlight the job order and click the [Delete] button next to the Job Order table.

Click the [Yes] button in the Confirmation window.

The Funding Sources window displays with the job order deleted from the table.

Click [OK] to return to the Contract Level Funding window.

From the menu, select File — Save to update the job order information and save the PR.
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Contracts Tab

The Contracts tab of the PR allows the PRweb user to designate Suggested Contract
Information, a Contract Number, and a Suggested Preference Program.

& Purchase Request - New -0l x|

File Line lterm

Purchaze Reguest Mumber

DPAS Pricrity Rating | Priarity

Description

Purchase
Request

Requistion Date
| 28-Jun-z002

hisin Fn:urml Line tem Contracts | Al Data

Suggested Contract Informatior

* Delivery Order  { Modification

Cartract Mumber Select.._l

Suggested Preference Program
IND Preference /Mot Listed ;I

|Java Applet Window

Figure 111: Purchase Request — New — Contract Tab

1. Select the appropriate Suggested Contract Information radio button.
The Suggested Contract Information radio buttons enable the PRweb user to suggest either
a Delivery Order or Modification for the requirement.

2. Click the [Select] button next to the Contract Number field.

The Contract Number search field allows the PRweb user to select an existing contract in
PD? and associate it with the PR. The Contract Number search field pulls all contracts
available in the PD? database that meet the PRweb user’s search criteria.
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The Attachment Search window opens.

Attachment Search x|
Search Critetia Documernt Type
IE IC:::nstruu:tiu:un Contract Awvard LI
Search By
Search I SE| et | Cancel | % Document Mumber " Document Title
Documert Mumber | Document Title

Java Spplet Window

Figure 112: Attachment Search Window

3. Select the appropriate contract type from the Document Type drop-down list box.

4. Enter Search Criteria, and click the [Search] button.

Note: For more information on searches, refer to “Search Function” section in Chapter 2:
PRweb Desktop.

b

Highlight the desired Document Number for the contract.

6. Click the [Select] button.
The Contracts tab displays with the selected contract in the Contract Number field.

7. Select the desired preference program from the Suggested Preference Program drop-down
list box.
The Suggested Preference Program drop-down list box allows the PRweb user to designate
the desired Preference Program for the requirement.

8.  Click the desired Preference Program.
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Add’l Data Tab

The Add’l Data tab allows the PRweb user to add any Additional Point of Contact (POC)
Information and Security Clearance Requirements. The user can also view any Contracting
Officer Notes (KO Notes).

& Purchase Request - New -0l x|

File Line lterm

Description Purchaze Reguest Mumber

DPAS Pricrity Rating | Priarity

Purchase
Request

Requistion Date
| 28-Jun-z002

llgin Fartn | Line tem | Contracts  Add’l Data |

Addtional Point of Contact (POC) Information  Select ... | Security Clearance Reguired

=

i o

WO Motes

&+ Unclassified ™~ Secret
" Confidential " Top Secret

|Java Applet Window

Figure 113: Purchase Request — New — Add’l Data Tab

1. Click the [Select] button next to the Additional Point of Contact (POC) Information field.

The Additional Point of Contact (POC) Information field allows the PRweb user to include
one additional POC on the PR. The POC information is pulled from the PD? database.
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The Contact Search window opens.

Contact Search

Search Critena Search By

IE * Code " Organization Mame

" Contact Mame ¢ Phone Mumber
Search I SElEmt I Cancel I £ State £ Zip Code
Contact | Code | Organizatian | City | State | £ip Code PH

LI 3

|'W'arning: Applet Window

Figure 114: Contact Search Window

2. Enter Search Criteria, and click the [Search] button.

Note: For more information on searches, refer to “Search Function” section in Chapter 2:
PRweb Desktop.

3. Highlight the desired contact.

4. Click the [Select] button.
The Add’l. Data tab displays the selected contact in the Additional Point of Contact
(POC) Information field. The [Select] button is now a [Remove] button.

5. Select the appropriate Security Clearance Required radio button.

The Security Clearance Required radio buttons enable the PRweb user to add additional
security information for the requirement.

Note: The KO Notes field is provided for the Contracting Officer (KO) to input any additional
requirement information in PD?. If the PR is returned to the PRweb user, the KO notes
are displayed in the field. In PRweb, this field is read-only.

Saving a Purchase Request

The Save menu option allows the PRweb user to save all changes made to the PR. Upon
completing a PR, the PRweb user must save the PR information. If the PR is updated with new
information, the PR must also be saved. To save a PR, select File > Save from the menu.

Note: Updating and saving are two separate functions. A PR that has been updated with
information needs to be saved in order to save the PR in its updated status.
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Closing a Purchase Request
The Close menu option allows the PRweb user to close the PR.
To close the PR:
1. From the menu, select File 2> Exit.
2. Click the [Yes] button in the Save Confirmation window if the PR information needs to be

saved. Click the [No] button in the Save Confirmation window if the PR information does
not need to be saved.

Note: If a PR has been updated with new information, it is necessary to save the PR before
closing it.

Editing a Purchase Request

PRweb users can open PRs for viewing from the Drafts, Inbox, Outbox and Archives folders.
Open PRs contained in the Drafts, Inbox or Outbox folders may also be edited.

To open a PR:

1. From the desktop, click the plus symbol (+) next to the desired folder (e.g., Drafts, Inbox,
Outbox, or Archive).

2. Highlight the PR.
3. From the menu, select Purchase Request - Open, or double-click the highlighted PR.

4. Edit or view the PR as necessary.

Note: For more information refer to Creating a New Purchase Request in this chapter.

Copying a Purchase Request

PRweb users can copy an existing PR that resides in any of the desktop folders. The ability to copy
PRs is a valuable tool that can reduce the creation time for a PR by eliminating repetitive data
entry. Using the Copy feature results in creating a copy of the entire PR including line items, and
funding. Funding that is not available to the specific user is not copied and the user is notified of
this in a Warning window.

Note: PRweb users can also copy PR Mods. However, the copied PR Mod displays in a
Purchase Request — New window.
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i PRweb =]

Mew...

Open...

Wigw Surnmary....

Delete

PR Status Report...
Standard Reports. ..

Renumber...
Raoute...

EERTEVE..,

Wiew Approval Hizton.

I acquzer]

|Warning: Applet Window

Figure 115: Purchase Request Copy Menu Option

1. From the PRweb user’s desktop, highlight the desired PR to be copied.

2. From the menu, select Purchase Request > Copy.
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The Purchase Request - New window opens.

& Purchase Request - New
File Line Iterm

=131 x|

Description Purchaze Reguest Mumber
Purchase | |copy of testizs] |
Requeat Requistion Date DRAS Priority Rating | Priarity

| 28-Jun-2002

Main Form | Lite Heml Cu:untrau:tsl ore | Datal

Requesting Office

Select.. |

A TER REED ARMY MEDICAL CEMTER
DIRECTORATE OF CONTRACTING
ATTR: HEHL-ZC, BUILDIMG T-20

ki

FY

i

lzzuing Office

Delete |

WAL TER REED ARMY MEDICAL CEMTER
DIRECTORATE OF COMTRACTING
ATTR: HEHL-ZC, BUILDIMNG T-20

Kl

s

o

Suggested Yendor(=)

Add...

Type of Action

&+ Small Purchase 8 Grants/Coops Agresment
™ Competed Contract " Sealed Bid

™ Mon-Competed Cortract  ( FSSIGSA Scheduls

" Manufacturer Sole Source © Commercial

" Delivery Ordet £ MIB S MISH JFR

" Task Crdet

Comments

|Java Applet \wWindow

Figure 116: Purchase Request — New — Main Form Tab

3. Enter a new description for the PR in the Description field, if necessary.

The Description field automatically populates with the description “Copy of <Description>.”

4. Enter a unique number in the Purchase Request Number field.

5. The user can make any necessary changes to the PR and associated line items, attachments,

and funding before saving the PR.

6. From the menu, select File > Save to save the PR Copy.
The copied PR display in the Drafts Folder.

Note:
the new PR.

Any information contained on the original PR that is PD*-specific data is not copied onto
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Copying a PR Mod

PRweb users can copy an existing PR Mod. This that resides in any of the desktop folders. The
ability to copy PRs is a valuable tool that can reduce the creation time for a PR by eliminating
repetitive data entry. Using the Copy feature results in creating a copy of the entire PR including
line items, and funding. Funding that is not available to the specific user is not copied and the user

is notified of this in a Warning window.

i PRweb =]

File Preferences QgMISyEEENSERIEEE Help

Wigw Surnmary....
.

Delete

PR Status Report...
Standard Reports. ..

Renumber...
Raoute...
EERTEVE..,

Wiew Approval Hizton.

I acquzer]

|Warning: Applet Window

Figure 117: Purchase Request Copy Menu Option

1. From the PRweb user’s desktop, highlight the desired PR Mod to be copied.

2. From the menu, select Purchase Request > Copy.
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The Purchase Request - New window opens.

& Purchase Request - New
File Line Iterm

=131 x|

Description Purchaze Reguest Mumber
Purchase | |copy of testizs] |
Requeat Requistion Date DRAS Priority Rating | Priarity

| 28-Jun-2002

Main Form | Lite Heml Cu:untrau:tsl ore | Datal

Requesting Office

Select.. |

A TER REED ARMY MEDICAL CEMTER
DIRECTORATE OF CONTRACTING
ATTR: HEHL-ZC, BUILDIMG T-20

ki

FY

i

lzzuing Office

Delete |

WAL TER REED ARMY MEDICAL CEMTER
DIRECTORATE OF COMTRACTING
ATTR: HEHL-ZC, BUILDIMNG T-20

Kl

s

o

Suggested Yendor(=)

Add...

Type of Action

&+ Small Purchase 8 Grants/Coops Agresment
™ Competed Contract " Sealed Bid

™ Mon-Competed Cortract  ( FSSIGSA Scheduls

" Manufacturer Sole Source © Commercial

" Delivery Ordet £ MIB S MISH JFR

" Task Crdet

Comments

|Java Applet \wWindow

Figure 118: Purchase Request — New — Main Form Tab

3. Enter a new description for the PR in the Description field, if necessary.

The Description field automatically populates with the description “Copy of <Description>.”

4. Enter a unique number in the Purchase Request Number field.

6. The user can make any necessary changes to the PR and associated line items, attachments,

and funding before saving the PR.

7. From the menu, select File > Save to save the PR Copy.
The copied PR display in the Drafts Folder.

Note:
the new PR.

Any information contained on the original PR that is PD*-specific data is not copied onto
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Deleting a Purchase Request
The Delete feature allows the PRweb user to delete existing PR and PR Mods that reside in the
user’s Drafts or Outbox folders. The user cannot delete a document that is in the Inbox or Archive
folders. Deleting a PR or PR Mod removes the document from the user’s desktop and the PRweb
database. The PR Number is then available for future use.
To delete a PR or PR Mod:
1. From the PRweb user’s desktop, highlight the desired PR or PR Mod to be deleted.

2. From the menu, select Purchase Request > Delete.

A Confirmation window appears to confirm the command to delete the document.

3. Click the [Yes] button.

Renumbering a Purchase Request

PRweb users can renumber a PR after it has been saved. A PR that resides in the Drafts, Inbox, or
Outbox can be renumbered.

1. From the PRweb user’s desktop, highlight the desired PR.

2. From the menu, select Purchase Request > Renumber.

The PR Renumber window opens.

PR Renumber

Current PR Number: |1 23T rain
Mew PR Mumber: I

k. Cancel

|Warning: Applet Window

Figure 119: PR Renumber Window

3. Enter the new PR number in the New PR Number field.

4. Click [OK] to save the new number.
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View Summary
PRweb users can view and print a synopsis of the PR information.
1. From the user’s desktop, highlight a PR.

2. From the menu, select Purchase Request > View Summary.

The Purchase Request Summary View window opens.

Purchase Bequest Summary Yiew
Deszcription: Training =
Number: Train123
Requisition D ate: 2R-Apr-2001
DPAS Prionty Bating:

Priority:
Type of Action: Small Purchaze
Comments: L.

Requesting Dffice:
DIRECTORATE OF PEMINSULA CONTRALCTING, ATTH: ATZF-DPCIEBUILDIMG 27461 HARRISON LOOR,
FORT EUSTIS, WA 23604-5293

Iszuing Office:

IJSPFO FOR PUERTO RICO. P.O. BOX 3786, SAM JUAN.. PR 00304-3735

Suggested Yendors:

FAIRCHILD SP & DEF CORP

Suggested Contract Information:  Delivery Order

Contract Number: DAk F36-01-C-0001 -
e

1] ~ ~

|Waming: Applet Window

Figure 120: Purchase Request Summary View Window
3. Click the [Print HTML Report] button.
A new Web browser window opens.

4. From the menu, select File = Print.

The PR prints to the machine’s default printer.

5.  From the Web browser window menu, select File = Close.

The Web browser window closes.

6. Click the [Close] button in the Purchase Request Summary View window.
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Chapter 5: PR Modifications

PRweb allows the PRweb user to create a PR
Modification by highlighting the archived PR. The PR
Modification (PR Mod) contains the contract and line
item level information from the archived base PR. The

In This Chapter...

Using the PR Modifications

PR Mod feature is similar to the PR feature. PRweb functlon‘s described in this chapter,
allows the requesting agent to create, route, approve, and you can.
submit the PR Mod to the Contracting Office. e Create a PR Modification

In order for a PR Mod to be created from a PR, following o Mikirge e P Ml e o0

criteria must be met: e Renumber a PR Modification

The PR has been approved in PD’

A PR Mod has not been created in PD? off the PR
An unapproved/unreleased PR Mod does not exist in PD?
A PR Mod for the selected PR is not in progress in PRweb

Note: If a new PR Mod is being created from an existing PR Mod that was created in PRweb,
the existing PR Mod must be approved and released in PD?.

The PR Mod that is created in PRweb will contain all the conform information that exists in PD?
for the base document. Attachments that have been generated with the base document will be
attached to the resulting PR Mod. However, the DD254 that was added to the base document is
not carried over to the PR Mod that is created in PRweb.

Creating a PR Modification

To create a new Purchase Request Modification:
1. Highlight the desired PR in the Archive folder.
2. From the menu, select Purchase Request > New = PR Modification.

AcquiLine PRweb v2.3 105 July 29, 2002
Functional User’s Guide



Chapter 5: PR Modifications

File Preferences @iy Transfer Help

- [d] @aonzss -
B[ Inko
D Cithio Wiew SUMMary...
B3 Archive COpy...
..... E =4
..... [elete

[:]

[&] @aooss ¢

_____ E QADDEZ [ PR Status Report...
T
[
i3

40033 [ Standard Reports...

----- [&] canmsa ¢

_____ Q0035 Renumber...
Foute. ..
Approve. ..

Wiewe Approval History ..

I maeyayhlanager

|Java Applet Window

Figure 121: New PR Modification Menu Option

3. Enter the PR Modification extension number in the Select Modification Number window.

& Select Modification Number X|

Previous PR Mumber IF‘R Test2

Mews PR Number.  [FR Testz: a0

Ol | Cancel

I-.lava Applet 'Window

Figure 122: Select Modification Number Window

Note: The Previous PR Number field is read-only. The PR Modification number consists of
the Previous PR Number and a four digit PR Modification extension number. The
extension number defaults to the next available number, however the PRweb user is able
to edit the extension number.

4. Click the [OK] button to create a new PR Modification.
The PR Modification displays.
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PR Mod - PR Test2-0001 =101 x|

File Line Item

Description Purchaze Request Mumber
Purchase | [rr tod JFR Test2-0001
Requeat R equizition 0 ate DPAS Prionty Rating | Prionty
J25-May-2002 B E

Main Form | Line tem | Contracts | &dd| Data |

Fequesting Office Select. | | Type of Action
Makisl SURFACE WARFARE CEMTER %" Small Purchase " Grants/Coops Agreement
gg‘em&glgglm‘l ™ Competed Contract {~ Sealed Bid
CRANE. IN 47522 ™ Mon-Competed Contract FSSJGS!—'? Schedule
" Manufacturer Sale Source ¢ Commercial
I ssuing Office Delete I ™ Delivery Order £ MIB / NISH # FFI
" Taszk Order

/8 TER REED ARMY MEDICAL CEMTER =

DIRECTORATE OF CONTRACTING c t

ATTM: HSHL-ZC. BUILDIMNG T-20 omments
|

ArT Fman

a

»
Suggested Yendor(z) Add... I

Warning: Applet Window

Figure 123: PR Mod - <PR Modification Number> Window

The PR Mod Header displays at the top of the PR Mod window and is visible from every tab of the
PR Mod window.

PR Mod - PR Test2-0001 =10l %]

File  Line Item

Dezcription Purchaze Request Number
Purchase  [Frtod JPR Test2-0001
REqueSt Requizition 0 ate DPAS Prianty Rating | Priarity
|25 May-2002 |3 |3

Figure 124: New PR Modification Header

5. Enter a description in the Description field.

Note: The PR Modification defaults the description to display “PR Mod”. However, the
PRweb user is able to edit the description.

The description allows the PRweb user to assign a descriptive reference of up to 60
characters. This field is required to save a PR.

6. The Purchase Request Number field is read-only and displays the PR Modification Number
previously selected.
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7. Enter the Defense Priority Allocation System (DPAS) Priority Rating in the DPAS Priority
Rating field.
This field holds up to 30 characters.

8.

Enter the appropriate priority number in the Priority field.
This field holds any number between 1 and 15.

Managing a PR Modification

The PRweb user is able to edit, view, copy, approve, and route PR Mods. Managing a PR Mod is
similar to managing PRs. For more information on managing a PR, refer to Chapter 4: Purchase
Request. For more information on routing a PR Mod, refer to Chapter 9: Workflow.

Renumbering a PR Modification

PRweb users can renumber a PR Mod after it has been saved. A PR Mod that resides in the

Drafts, Inbox, or Outbox folders can be renumbered. PR Mods that are in the Archive folder
cannot be renumbered.

1. From the PRweb user’s desktop, highlight the desired PR.

2. From the menu, select Purchase Request > Renumber.

The PR Renumber window opens.

& PR Renumber

current PR Mumber: IF‘R Test2-0001

MNews PR Number. [P Testz |

Ok I Cancel

Java Applet Window

Figure 125: PR Renumber Window

3. Enter the new PR Modification extension number in the New PR Number field.

4. Click [OK] to save the new number.
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Chapter 6: Line Item

Creating a Line Item In This Chapter...

Using the Line Item Detail functions

1. From the menu, select Line Item - New 2> R T ————

CLIN.

The Line Item Detail — New window opens * Createa Line Item

with the Detail tab displayed. e Manage Funding Sources
The Line Item Detail header displays at the top * Manage Funding Strips
of the Line Item form and is visible from every e Manage Job Orders
tab of the Line Item Detail window. e Create a SubCLIN

i Line Item Detail - New ;lglﬂ

File Funding

Line ltem Detail Murmnber Dezcription
(T |

Detail | pezcription | Funding | Shifping | Local Infa

MNSM: | Select... |
Deliveny Date: % (] | = =)
Start Date End D ate
Period of Performance: %’”:I éwl‘
CLIM Type: & Piiced ¢ |nfg Orily
Estended Description:
[uiantity E stimated Unit Price Eztimated Line ltem Cost
[tern Calculation: | X | = |
Period: " Option (* Base Opt. #: Unit of |szue
MILSTRIP: | | |

|'-.-'-.-'arning: Applet Window

Figure 126: Line Item Detail — New - Detail Tab
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2. Enter a description in the Description field.

The Description field for the line item holds up to 65 characters.

Detail Tab

The Detail tab allows the PRweb user to provide information pertaining to the NSN, Delivery
Date, or Period of Performance, as well as CLIN Type, Extended Description, Quantity,
Estimated Unit Price, Period, Option Number (if applicable), MILSTRIP, and Unit of Issue.

i Line Item Detail - New - 10| x|
File Funding

Murnber Description

Line ltem Detail
{lnoo |

Detail | De=scription | Funding | Shipping | Local Info |

NSN: | Select. |
Diefiveny D ate: I % i:l | =l =)
Start Date End D ate
Period of Performance: I %’”:I I épl‘
CLIM Type: & Priced ¢ |nin Ol
Estended Description:
[Auiantity E ztimated Lnit Price E ztimated Line Ikerm Cost
[tem Caloulation; | X I = I
Period: " Dption * Base Opt. #: I Unit of lssue
MILSTRIP: | | =1

|Warning: Applet Window

Figure 127: Line Item Detail - New — Detail Tab

1. To associate an NSN with the line item, click the [Select] button next to the NSN field.
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The NSN Search window opens.

Mshsearch x|
Search Criteria

Search By:

o+ MSH
™ Description

B

Search Results:

MSH ['ezcrption Unit of lzzue | YWar Gty + "-;"arDt_l,l-| BN:’SS|

Search Select Cancel

Mvarning: Applet Window

Figure 128: NSN Search Window

2. Enter Search Criteria, and click the [Search] button.

Note: For more information on searches, refer to “Search Function” section in Chapter 2:
PRweb Desktop.

3. Highlight the desired NSN.

4. Click the [Select] button.

The selected NSN automatically populate the following fields with information from PD?*:
NSN, Description, Extended Description, Unit of Issue, Var in Qty +, Var in Qty —, and
Brand Name/Sole Source.

Note: If no information exists in PD* for Variation in Quantity(+), Variation Quantity (-)%, or
Brand Name/Sole Source, then the search shall display these fields as blank.

5. There must be a Delivery Date or Period of Performance entered in order to save the line
item.
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Note: If the Priced radio button is selected, a Delivery Date or Period of Performance is
required. If the Info Only radio button is selected, the Delivery Date or Period of
Performance is not required.

a. If the line item requires a specific delivery date, enter it in the Delivery Date field
manually or use the Auto-Calendar feature.

b. If'the line item requires an ADC or AFATA delivery date, select the appropriate units of
time from the drop-down list box to the right of the Delivery Date field and enter the
numeric value in the field on the left.

c. Ifthe line item requires a Period of Performance, enter it in the Start Date and End Date
fields manually in the Period of Performance field, or use the Auto-Calendar feature.

Note: Only one date type can be entered, a Delivery Date or a Period of Performance date.

6. IfaPD? user adds multiple delivery information to a PR and return routes that PR to PRweb,
PRweb will display a [Multiple Deliveries] button instead of the Delivery Date or the Period
of Performance ficlds. To see a summary of the multiple delivery information, click on the
[Multiple Deliveries] button. PRweb displays the multiple delivery information in a
summary format that is read-only.

: Line Item Detail - 0001 =101 x|

File Funding

Line ltem Detail Mumber Dezcription
Jnoo [Chock Wheel, Painted

Detail | Dezcription | Funiling | Shifping | Lacal Infa

RSH: |'I?3EI-EIEI-NIB-EIEI'IE Select... |

Multiple Delivenes |

CLIM Type: & Priced © Info Orly

Extended Deszcnption: | The chocks are made of finighed., planed kiln-dried wood blocks.
There are two types of four options:

[Iuiantity Eztimated Unit Price E ztimated Line Item Cost
Itern Calculation: [200.00 X [200.00 = |$40,000.00
Period: " Option % Baze Opt. #: Urit of ssue
MILSTRIF: | | Each =

|'-.-'-.-'arning: Applet Window

Figure 129: Line Item Detail — 0001 — Detail Tab
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Multiple Delivery Detail - D001 x|

Delivery Date | Quantity | Ship To Address | uic
17-0u2002  120.556  USPFO FOR VIRGINIA DAHA4
501 EAST FRANKLIN STREET
RICHMOND,, WA 232182317

12 hrs ADC 859.45 1 COMNSICC F44600
74 MEALY AVENLUIE
SUITE 109
LAMGLEY AFB, WA 23665-2088

‘Warning: Applet \Window

Figure 130: Multiple Delivery Detail - 0001

7. Enter a more detailed description of the line item, if necessary, in the Extended Description
field.

This field holds up to 255 characters.
8. Enter a quantity in the Quantity field.

9. Enter an amount in the Estimated Unit Price field.

The PRweb module automatically calculates the line item cost out to five decimal places. The
user must include the quantity in order to save the line item.

Note: A dollar sign is not required when entering the estimated cost of each unit.

10. Select the Option or Base Period radio button.

11. Enter the appropriate number of days in the Opt # field, if it is an option period line item.

This field holds up to four characters. The specified number of days represents the period’s
duration in days.

12. Enter the MILSTRIP information in the MILSTRIP field if necessary.
This field holds up to 30 characters.

13. Select the appropriate unit of issue from the Unit of Issue drop-down list box.
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Description Tab

The Description tab in the Line Item Detail window allows the PRweb user to further specify
details pertaining to the line item. The user can include the Manufacturer, Manufacturer Part
Number, Vendor Number, Product/Category Number, Drawing Number, Specification
Number, Serial Number, Piece Number, Model Number, Color, Size, SMIC, Positive
Variation in Quantity, Negative Variation in Quantity, Project Number, FSC code, SIC
code, Brand Name/Sole Source and NAICS code on this tab.

i Line Ttem Detail - 0001 - O] x|

File Funding

Murnber Dezcription

{0001 |

Detzil  Description | Fundingl Shippingl Local |nfc.|

Line ltem Detail

b arufacturer: Calect. . |
b arufacturer Colar: I

Part Mumber:

Yendor Mumber; Size: |

Prod. /Cat. Mumber: SMIC: |

Spec. Mumber: Project: |

Fsc: | =l
S B
Brand Name/Sale Source| = |
MNAICS: | =

Sernial Humber:

Piece Mumber:

|
|
|
|
Drrawing Mumber: I Var Gty + I— Var Gty - I—
|
|
|
|

b odel Mumber;

Warning: Applet Window

Figure 131: Line Item Detail — New — Description Tab

1. To associate a manufacturer with the line item, click the [Select] button next to the
Manufacturer field.
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The Vendor Address Search window opens.

Yendor Addrezs Search

Search Criteria Search By

IE f* Code ™ Phone Mumber

' Mame " Zip Code
Search | Selest | Cancel | € State
Code | Organization | Street | City | State| £ip Code | A

LI 3

|'W'arning: Applet "Window

Figure 132: Vendor Address Search Window

2. Enter Search Criteria, and click the [Search] button.

Note: For more information on searches, refer to “Search Function” section in Chapter 2:
PRweb Desktop.

3. Highlight the desired manufacturer.

4. Click the [Select] button.

The selected manufacturer displays in the Manufacturer field in the Description Tab.

5. Enter the manufacturer number of the requirement in the Manufacturer Part Number field.

This field holds up to 40 characters.

6. Enter the appropriate vendor number of the requirement in the Vendor Number field.

This field holds up to 40 characters.

7. Enter the product/category number of the requirement in the Prod./Cat. Number field.
This field holds up to 25 characters.

8. Enter the drawing number in the Drawing Number field.

This field holds up to 25 characters.

9. Enter the specification number of the requirement in the Spec. Number field.

This field holds up to 15 characters.

10. Enter the serial number of the requirement in the Serial Number field.
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

This field holds up to 15 characters.

Enter the piece number of the requirement in the Piece Number field.

This field holds up to ten characters.

Enter the model number of the requirement in the Model Number field.

This field holds up to ten characters.

Enter the color of the requirement in the Color field.

This field holds up to 15 characters.

Enter the size of the requirement in the Size field.

This field holds up to 30 characters.

Enter the Special Material Identification Code (SMIC) of the requirement in the SMIC field.
This field holds up to two characters.

Enter the Positive Variation in Quantity of the requirement in the Var Qty + field.

This field holds a number greater than zero and equal or less than 10 with up to 2 decimals.

Enter the Negative Variation in Quantity of the requirement in the Var Qty - field.

This field holds a number greater than zero and equal or less than 10 with up to 2 decimals.

Enter the project number/description of the requirement in the Project field.

This field holds up to ten characters.

Select the Federal Supply Classification (FSC) code from the FSC drop-down list box.
Select the Standard Industrial Classification (SIC) code from the SIC drop-down list box.
Select the Brand Name/Sole Source from the Brand Name/Sole Source drop-down list box.

Select the North American Industry Classification Standards (NAICS) code from the NAICS
drop-down list box.
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Funding Tab

The PRweb module provides the ability to add funding at the line item level or assign contract
level funding. For more information on contract level funding, refer to Chapter 4: Purchase
Request. The user can add line item level funding from within the Line Item Detail window. The
Funding tab displays line item funding information. The cumulative amount of funding
automatically displays on the Line Item tab of the PR. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information
is read-only.

& Line Item Detail - New = 0] x|
Li ' _ letall Murmber Description
Edlt.. {0001 | Tool Box and Kit
—— [elgte...
Dretail I Description Funding | Shippitg | Local Info |
Funding Strig Funded Ax
1 [+
Java dpplet window
Figure 133: Line Item Detail - New — Funding Tab
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Creating a New Funding Source

PRweb users can create funding sources at the contract level. The System Administrator grants
user rights to manage funding information. If the user does not have these rights, funding
information is read-only.

1. From the menu, select Funding — New.

The Funding Sources — New window opens with the funding header displayed at the top.

The funding header includes the Number, Description, and the Total Estimated Cost of the
line item. The data contained in these fields is retrieved from the Detail tab.

& Funding Sources - New |

Funding Sources

Murmbet: ||:||:||31 Description: IT.:..:.l B and kit
Total Estimated Cost: I!BEI,SEIEI.EID
Fund Strip CRiew ] e I hManage I
Funded Amount: |$9,SDD.DD Fund ACRMN: I
Job Order | Expiration Date | Quantity | Funded Mmoot Adld... |
Edit....

Total Guantity: I Total Amounit; I Dielete |

0] | Cancel |
I-_lava Applet Window
Figure 134: Funding Sources — New Window
2. To search for an existing funding strip, click the [Manage] button.
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The Funding Strip Search window opens.

Funding Strip Search
Search Criteria: I;c«_j Search By
% Code
ew... | ity | (B, | [elete | T User ID
Search | Select | Cancel | Template: |I3I|:|I:|a| ;I
Code | Uzer D
=l 5

|'W'arning: Applet Window

Figure 135: Funding Strip Search Window

3. Select the appropriate template from the Template drop-down list box.

Note:

Selecting “Global” in the Template drop-down list box searches across all templates.

4. Enter Search Criteria, and click the [Search] button.
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The search results display.

Funding Strip Search x|
Search Criteria: IE Search By
* Code
ey, . | Exit... | Copy... | Delete " Lser 1D
Search I Select I Cancel I Template: I.&rmy-' ll
Code =zer |0

1| Ir

Java Applet Window

Figure 136: Funding Strip Search Window

Note:  Only funding strips that have been created by the user or released by the PD* System
Administrator are displayed.

5. If the desired funding strip is not found, skip to step 8. If it is found, continue with step 6.
6. Highlight the desired funding strip and click the [Select] button.

7. Skip to step 13.

Note: For more information on searches, refer to “Search Function” section in Chapter 2:
PRweb Desktop.

8. If the funding strip is not found, click the [New] button.
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The <Default Template> Funding Strip — New window opens.

Army Funding Strip - New x|

Fund Strip

Departrment Codel2)

Fiscal Yeari1]

AppropristionBasic Symbol(4) Limnitation4)

Program Year(1) Operating Agency(2)

Allotrment Serial Mumber; 43 Prograrm Element(111

Element of Resource(4) MOEPSSODPIE)

Document Reference Mumber(1 43 Accounting Processing Code(B)

Fiszal Station Murnber(E)

Select Template: Army - I Ok | Claze

Java Applet wWindow

Last Digit(1}

Figure 137: Army Funding Strip - New Window

Note: The default funding strip template set by the System Administrator displays. If the
System Administrator has not selected a default template, you cannot continue.

9. To change to an alternate template, select another template from the Select Template drop-
down list box.

10. Enter the funding strip information in the appropriate fields.

Note:  Each field must either be filled out completely or left blank.

11. Click [OK].

The funding strip displays on the list of available funding strips in the Funding Strip
Search window.

12. Highlight the new funding strip and click the [Select] button to select the new funding strip.

13. Enter the appropriate fund amount in the Funded Amount field.

The Funded Amount field allows the PRweb user to enter the desired dollar amount to
correspond with the selected funding strip. (It is not required to enter a dollar sign.)

Note: The Funded Amount defaults to the total cost of the line item.

14. Enter an ACRN in the Fund ACRN.

The Fund ACRN field allows users to enter ACRN information in the Funding Source
window. This field holds up to two characters.

15. Click [OK] to save.

Note: The PR must be saved to save the new funding source.
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Editing a Funding Source

PRweb users can edit funding sources at the contract level. The System Administrator grants user

rights to manage funding information. If the user does not have these rights, funding information
is read-only.

£ Line Item Detail - 0001

=101 %]
File  Funding
' ' uimiky (] ipoti
Line ltem Detail | "“meer escripfion
{0001 | Taol Box and Kit
Detail | Desctiption  Funding | Shipping | Lacal Infao |
Funding Strig Furnded Ly
212000 2808 00 2 ABSSSEECCCCCCESETFISDEIT 1111111111111 22222231 9,
1 [+
Java Applet \Window

Figure 138: Line Item Detail - <Line Item Number> - Funding Tab

From the Funding tab of the Line Item Detail window, highlight the funding source to be
edited.

2. From the menu, select Funding - Edit.

Note: The PRweb user can also double-click on the funding source to open the highlighted

funding source.

AcquiLine PRweb v2.3

122
Functional User’s Guide

July 29, 2002



Chapter 6: Line Item

The Funding Sources window opens.

& Funding Sources ﬂ

Funding Sources

Mumber: 0001 Deseription: | Tool Box and Kit
Total Estimated Cost: |$9,snn.nn
Fund Ztrip Mlews. | Eciit .. Manage_._l

|21 2hl] 28808 8 344BSSSEECCCCCCESETFEE0ESI99 1111 111111111 222222323F 553

Funded Amaunt; |$9,5EII:I.EIEI Fund ACRM: I
Add. .. |

Edlit...

Tatal Quantity: II:I.D Total Amount:  |0.00 Delete |

Ok | Cancel |

|Java Applet Window

Figure 139: Funding Sources Window

3. Make desired changes and click [OK] to return to the Line Item Detail window.

4. From the menu, select File - Update to update the line item with the funding information.

Note: The PR must be saved to save the new funding source.

Deleting a Funding Source

PRweb users can delete funding sources at the contract level. The System Administrator grants
user rights to manage funding information. If the user does not have these rights, funding
information is read-only.
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& Line Item Detail - 0001 : =0 =l

File  Funding

Murmber Description

Line ltem Detail
{0001 | Tool Box and Kit

Detaill Description Funding | Shippingl Local Info

Funding Strig Funded A

2120 344B5: 9111111111111

Java dpplet window

Figure 140: Line Item Detail - <Line Item Number> - Funding Tab

1. From the Funding tab of the Line Item Detail window, highlight the funding source to be
deleted.

2. From the menu, select Funding — Delete.

3. Click the [Yes] button in the Confirmation window.

The Funding tab displays with the funding source deleted from the table.

4. From the menu, select File = Update to update the line item with the funding information.

Note: The PR must be saved to save the funding source.

Creating a New Funding Strip

PRweb users can create funding strips at the line item level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information
is read-only.
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i Line Item Detail - D002 = e
Funding

S e

Flaztic hinged hd tool box with a remowvable tray which can also be
uzed az a step stool. The box haz a recezszed camving handle. In
the kit are warious hand toolz such az pliers, wrenches, screwdrivers,
tape meazure, knife, safety goaagles, hammer, fla

|

D

Figure 141: Line Item Detail — New Window

1. From the menu, select Funding — New.
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The Funding Sources — New window opens.

£ Funding Sources - New

Figure 142: Funding Sources — New Window

2. Click the [New] button.
The <Default Template> Funding Strip — New window opens.

Army Funding Strip - New

Figure 143: Army Funding Strip — New Window

3. To change an alternate template, select another template from the Select Template drop-
down list box.
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4. Enter the funding strip information in the appropriate fields.

Note: Each field must either be filled out completely or left blank. However some fields may
be required, depending on how the System Administrator configured the funding
template.

5. Click [OK].
The funding strip displays in the Fund Strip field of the Funding Sources - New window.

6. Click [OK] to return to the Line Item Detail window.

7. From the menu, select File - Update to update the line item with the funding information.

Note: A new funding strip may also be created from the Funding Strip Search window by
clicking the [New] button.

Note: The PR must be saved to save the new funding strip.

Copying a Funding Strip

PRweb users can copy funding strips at the line item level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information
is read-only.
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k |ine Item Detail - New

Funding

Figure 144: Line Item Detail — New — Funding Tab

1. From the menu, select Funding — New.
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The Funding Sources — New window opens.

Funding Sources - Mew E

Funding Sources

Mumber; |E||:||:|1 Description: |

Total Estimated Cost: I

Fund Stip CHen | Fdi | Manage. |

Funded Amount: |$D.DEI Cost Code: IDDDDDDDDDDDD Fund ACEN: I

bOde [ EistonDae | Gueniy | Fondeddmown|  add |
Edlit, . |

Total Cluantity: I Total Amaount; I [ielete |

Ok | Cancel |
|Waming: Applet Window
Figure 145: Funding Sources — New Window
2. Click the [Manage] button.
The Funding Strip Search window opens.
Funding Strip Search Ei
Search Criteria: I;?q Search By
& Code
Mew. .. | Edif.. | [Eam., | [Melete I " UserID
Search | Selent | Cancel | Template: IGIDI:uaI ;I
Code | Uzer D
=X 3
|'W'arning: Applet Window
Figure 146: Funding Strip Search Window
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3. Select the appropriate template from the Template drop-down list box.

4. Enter Search Criteria, and click the [Search] button.

Note:  For more information regarding searches, refer to the “Search Function” section in
Chapter 2: PRweb Desktop.

Funding Strip Search 5'
Search Criteria: IE search By
> Code
M. . | Eclit... | Copy... | Delete " User ID
Search I Select I Cancel I Template: I.-'J-.rm':.-' LI

‘| [

Java spplet Window

Figure 147: Funding Strip Search Window

5. Highlight the desired funding strip and click the [Copy] button.

The <Default Template> Funding Strip - Copy window opens with the copied funding
strip information in each field.

Army Funding Strip - Copy 5[
Fund Strip
559597559447 7944448944455 qgh 45457 5899r55554 444444444897 394 3999998
Department Code2) Iaa Fiscal Year(1) Ig
AppropristionBasic Symbol(4) IBQ?B Limitstion(4) |3944
Program Year(1) I? Operating Agency(2) I?g
Allotment Serial Mumberid) |4444 Prograrm Element(11] |8944455tggh
Elemerit of Resourceld) |4545 MDERPISODPIE] |?8899r
Docurment Reference Mumber(14) |33334444444444 Accourting Proceszsing CodelB) |sg?394
Fizcal Station Mumber(5) |399999 Lzt Digit(1) |3

Select Template: Zrmy VI Ok | Cloze

Java Applet Window

Figure 148: Army Funding Strip — Copy Window
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Note: The funding strip is copied into the template that corresponds with the PRweb template
used to create the original funding strip. If the funding strip was created with a PRweb
template that has either been disabled or updated, the PRweb user is unable to copy the
funding strip. In addition, funding strips that were routed from PD? will display as
Miscellaneous.

6. Make the desired changes to the funding strip.
7. Click [OK] to save the changes and return to the Funding Strip Search window.
The new funding strip displays in the Funding Strip Search window.

8. Highlight the funding strip and click the [Select] button to select the new funding strip.
9. Click [OK] to return to the Funding tab of the Line Item Detail window.

10. From the menu, select File = Update to update the line item with the new funding
information.

Note: The PR must be saved to save the edited funding strip.

Editing a Funding Strip

PRweb users have two options for editing funding strips at the line item level. The System
Administrator grants user rights to manage funding information. If the user does not have these
rights, funding information is read-only.

If the System Administrator has updated or removed the template from which the selected funding
strip was created from, PRweb alerts the user that the template has changed.

Confirmation

@ The funding template uzed to create this
funding stip has been changed or disabled.
Select "es' to update using new funding

template. Select Mo’ to view selected
funding strip az read anly.

Tes | Mo

|Waming: Applet Window

Figure 149: Confirmation Window
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If the user selects [Yes], the PRweb user is able to create a new funding strip using the updated
version of the template or specify another template.

Army Funding Strip - Hew
Fund Strip
Department Code[2] I Fizcal Year(1] I
Appropriation/Bazic Symbal(4] | Lirnitation(4] |
Frogram vear(1] I Operating Agency|2] I
Allotrment Serial Mumber[4] I Program Element{11] I
Element of Resourcel4] | MDEP/SODP(E] |
Document Reference Mumber(14] I Aocounting Proceszing Code(g) I
Fizcal Station Murmber[B] I Lazt Digit[1] I
Select Template: Ay 'I Ok I Cloze
|W’arning: Applet Window
Figure 150: Army Funding Strip — New Window
If the user selects [No], the funding strip displays as read-only.
Army Funding Strip - [Read Only] E
Fund Strip
ISS‘I 124B122230A417118PRET 2300997 W 3334B 9085 PO40026G 09340506 7 8R5A 2334
Department Code(2] Igg Fizzal Year(1) |1
Appropriation/B asic Symbol(4) |1 AR Limitation(] |1 279
Program Year(1] |3 Operating Agency(2] IDA
Allatment Serial Mumnber(4) |-| 118 Program Element(11] IPHE-| 2300997
Element of Resource(d) Ingg MDEF/SODP(E) |34Egng
Dacument Reference Number(14] Ispn4gng55n9345 Accounting Processing Code(B] |555?35
Fiscal Station Number(&) IS'{\2334
Select Template: &y "I oy | Close
|Waming: Applet Window

Figure 151: Army Funding Strip — (Read Only) Window
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Option 1: By Funding Strip Search

& Line Item Detail - 0001 S
File  Funding —I—I
i o | Mumby 3] itati
Line Item Detail ™" escription
o001 | Tool Box and it

Detaill Description  Funding | Shippingl Local Infu:ul

111111111111

Java dpplet window

Figure 152: Line Item Detail - <Line Item Number> - Funding Tab

1. Highlight the funding source to be edited.

2. From the menu, select Funding — Edit.
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The Funding Sources window opens.

Figure 153: Funding Sources Window

3. Click the [Manage] button.
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The Funding Strip Search window opens.

Funding 5trip Search
S earch Criteria: IE Search By
& Code
Mew... | Edit... | [Eap. | [elete | " User ID
Search | SElEk | Cancel | Ternplate: |I3I|:|I:|a| ;l
Code | ger D
= v

|'W'arning: Applet \windom

Figure 154: Army Funding Strip — Edit Window

4. Enter Search Criteria, and click the [Search] button.

Note:  For more information regarding searches, refer to the ‘Search Function” section in
Chapter 2: PRweb Desktop.

5. Highlight the desired funding strip and click the [Edit] button.
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The Army Funding Strip — Edit window opens with the original funding information
displayed.

Note: You may not edit a funding strip that is applied to either another PR or another funding
source on the same PR.

Army Funding Strip - Edit x|
Fund Strip
21 2h1 288 A8 3448555660 CCCCCEEET 7EE0DES89 11 1111111111 11 222222323F 555
Department Code(2) |21 Fizcal Year(1) Iz
AppropristionBasic Symbol(4) Imum 2 Lirnitation(4] I,a_,a\,.r_\g
Programm Year(1) |3 Operating Sgency(2) |44
Allotrment Serial Mumber; 43 |EISSS Prograrm Element(111 |55cccccc533
Elemert of Resourceld) I??aa MOEPYSCODP(E) IDEEIEIEIEI
Document Reference Mumber(1 43 |1 1111111111111 Accounting Processing Code(B) |222222
Fizcal Station Mumber(6) |323F33 Last Digit(1) |3

Select Template: Sy ht I Ok | Close

Java Applet wWindow

Figure 155: Army Funding Strip — Edit Window

6. Make desired changes to the funding strip and click [OK] to return to the Funding Strip
Search window.

7. Click the [Select] button to select the updated funding strip and return to the Funding
Sources window.

8. Click [OK] to return to the Funding tab of the Line Item Detail window.

9. From the menu, select File — Update to update the line item with the new funding
information.

Note: The PR (or PR Mod) must be saved to save the edited funding strip.
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Option 2: By Funding Sources Window

& Line Item Detail - 0001 o ] 3

File  Fumding

Mumber Description

Line ltem Detail

{0001 | Tool Box and Kit

Detaill Description  Funding | Shippingl Local Infu:ul

Fudnosip |ruedn

111111111111

Java dpplet window

Figure 156: Line Item Detail - <Line Item Number> - Funding Tab

1. Highlight the desired funding source.

2. From the menu, select Funding — Edit.
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The Funding Sources window opens.

% Funding Sources x|
Funding Sources
Mumber: 0001 Deseription: | Tool Box and Kit
Tatal Estimated Cost: I!BEI,SEIEI.DD
Fund Ztrip Mlews. | Eciit .. Manage_._l
2 2] 20,00 0 34 4RSS SCCCCCCORRT T TEEDED999 111111111111 222222 3F 35553
Funded Amaunt; |$9,5EII:I.EIEI Fund ACRM: I
Job Creler | Expiration Date | Cluattity | Funded Amourt Add.... |
Edit....
Total Quartity: II:I.D Tatal Amount: (000 Delete |
Ok | Cancel |
|Java Applet Window

Figure 157: Funding Sources Window

3. From the Funding Sources window click the [Edit] button next to the Fund Strip field.

The Funding Strip — Edit window opens with the original funding information displayed.

Army Funding Strip - Edit 5'
Fund Strip
2120 24883448555 CCCCCCCEETTTTEEDE999 111 11111111 11 2222223F 58883
Depattment Codel2) |21 Fizcal Year(1) |2
AppropristionBasic Symbol(4) |Mw1 2 Litvitation;4) |,.v_~.,,a\,.r_\.,g
Progratn Year(1) |3 Operating Agency(2) |44
Allattnert Serial Number(4) |EISSS Progratn Element(117 |cc¢¢ccc53??
Eletriert of Resource(d) I??BB MOEPISCDPE) |DE9999
Document Reference Mumber(1 4] |1 111111111114 Accounting Processing Code(B) |222222
Fizzal Station Mumber(6) |3F8333 Last Digit(1) |3
Select Template: ~rimy vI (64 | Cloze

Java dpplet Window

Figure 158: Army Funding Strip — Edit Window
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4. Make desired changes to the funding strip and click [OK] to return to the Funding Sources
window.

5. Click [OK] to return to the Funding tab of the Line Item Detail window.

6. From the menu, select File - Update to update the line item with the new funding
information.

Note: The PR must be saved to save the edited funding strip.

Deleting a Funding Strip

PRweb users can delete funding strips at the line item level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information
is read-only.

! Line Item Detail - 0001 [ (O] x|

File  Funding

M urnber Dezcrption

Line Item Detail
([ | Training

Detaill Description  Funding | Shippingl

1E1107510331133821471 957123342391 1 29334751 833833431 3367133851348 10

|Warning: Applet Window

Figure 159: Line Item Detail — <Line Item Number> - Funding Tab
1. Highlight the desired funding source.

2. From the menu, select Funding — Edit.
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The Funding Sources window opens.

Funding Sources E2
Funding Sources

Mumber; |E|I:|I:|‘| Description: |Training

Total Estimated Caost: |$1 0,000.00

Fund Stip Mew.. | TEdE™| Manage.. |
|1 2110757103817 99831 4719571 2534331 3129334 751 833893481 9367193851 3451

Funded Amount: |$1 0,000.00 Cozt Code: IEIDEIEIEIDDDDDEID Fund ACRM: I

b0 | Eweonbste | Queiy | Fundedbmonn | asd |
Edit. . |

Tatal Quantity: ID.EI Tatal Amaunt: |00 Delete |

Ok | Cancel |

|Warning: Applet Window

Figure 160: Funding Sources Window

3. Click the [Manage] button.
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The Funding Strip Search window opens.

Funding 5trip Search
Search Criteria; I% Search By
* Code
MHew... | it | (B | [Ielete | " User ID
Search I SElect I Cancel I Template: IGIDI:ual ;I
Code | zer D
LI 3
|'W'arning: Applet Window

Figure 161: Funding Strip Search Window

4. Enter Search Criteria, and click the [Search] button.

Note: For more information regarding searches, refer to the “Search Function” section in
Chapter 2: PRweb Desktop.

5. Highlight the desired funding strip and click the [Delete] button.

Note: You may not delete a funding strip that is applied to another PR, a line item on the same
PR or the same line item on a different funding source.

6. Click the [Yes] button in the Confirmation window.

The Funding Strip Search window displays with the funding strip deleted from the table.
7. Click the [Cancel] button to return to the Funding Sources — New window.
8. Click [OK] to return to the Funding tab of the Line Item Detail window.

9. From the menu, select File & Update to update the funding information.

Note: The PR must be saved to save the funding information.
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Creating a Job Order

PRweb users can create job orders at the contract level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding and job order
information is read-only.

ine Item Detail - New

oot Toolboxes|

Fudrgsie | Fueda

Figure 162: Line Item Detail — New — Funding Tab

1. From the menu, select Funding — New.
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The Funding Sources — New window opens.

£ Funding Sources - New

Figure 163: Funding Sources — New Window

2. Click the [Add] button next to the Job Order table.
The Attach Job Order — New window opens.

Figure 164: Attach Job Order — New Window

3. Click the [Select] button.
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The Job Order Number Search window opens.

Job Order Mumber Search

Search Critetia

IE [¥ Current Job Croers Only

ey I Search Select

Cancel

Jok Order Mumber Fundz Expiration Date

Java Applet Window

Figure 165: Job Order Number Search Window

4. Click the [New] button.

The Create New Job Order window opens.

& Create New Job Order x|

Job Croder Mumber: ||

Funds Expiration Date: I

Ok | Cancel

Jawa Applet Window

Figure 166: Create New Job Order Window

5. Enter a number in the Job Order Number ficld and an expiration date in the Funds

Expiration Date field.

Note: The funds expiration date can be entered manually or by using the Auto-Calendar feature.

6. Click [OK] to return to the Job Order Number Search window.

7. Double-click the new job order to return to the Attach Job Order — New window.

8. Click [OK] to return to the Funding Sources — New window.

The job order displays in the Funding Sources — New window.

9. Click [OK] to return to the Funding tab of the Line Item Detail window.
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10. From the menu, select File = Update to update the funding information.

Note: The PR must be saved to save the funding information.

Attaching a Job Order

PRweb users can attach job orders at the line item level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding and job order
information is read-only.

& Line Item Detail - New : o ]

File  Funding

Line Item Detail Mumber De=scription

{0001 | Taclkoxes|

Detaill Desciption  Funding | Shippingl Local Infu:ul

Java applet \Window

Figure 167: Line Item Detail — New — Funding Tab

1. From the menu, select Funding — New.
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The Funding Sources — New window opens.

& Funding Sources - New x|

Funding Sources

Murmber: ||:||:||31 Description: |Tnnlhnxes
Total Eztimated Cost: |$EI,5IIIEI.IIIEI
Fund Strip My I Edit. . I Manage_._l

Funded Amaunt: IﬂiEl,SI:IEI.DD Fund &CREM: I

Jaob Crder | Expiration Date | Cuantity | Funded Armaount Addd.. |

Ediit....

Total Quantity: II:I.I:I Total Amount:  |0.00 Delete |

Ok | Cancel |

|-_|a\-'a Applet wWindow

Figure 168: Funding Sources — New Window

2. Click the [Add] button next to the Job Order table.
The Attach Job Order - New window opens.

Attach Job Order - Hew

Job Order: I
Funded &mount; IN A
Funded Cluantity: IN I

k. Cancel

|Warning: Applet Window

Figure 169: Attach Job Order — New Window

3. Click the [Select] button.
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The Job Order Number Search window opens.

Job Order Number Search x|
Search Criteria
IE W Current Job Orders Only
e | Search melect Cancel
Job Order Mumber Fundz Expiration Date
Java applet \Window

Figure 170: Job Order Number Search Window

4. Enter Search Criteria.
5. Check the Current Job Orders Only checkbox to display job orders that have not expired.
6. Click the [Search] button.

The search results display.

Job Order Number Search x|
Search Criteria
IE W Current Job Orders Only
e | Search Select Cancel |
Job Order Mumber Fundz Expiration Date j
C000029491 15-Feh-2003
CO0EZ9Ta 14-Mary-2003
DUPOOO1 12-Mary-2201
DUPO0O1 10-Mary-2021
ERKOM 3 -Dec-2002 ||
ERKOO 3 -Dec-2022
ERKOO2 3 -Dec-2002
HHH111 10-Mary-2004 =
1| [ 5
Java applet \Window
Figure 171: Job Order Number Search Window
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7. Highlight the desired job order number and click the [Select] button.
The Attach Job Order — New window opens.

& Attach Job Order - New

Job Crder: ICEIEIEISEMEI‘I

Funced Amourt: |11/

Funced Quartity: |Nm

Ok Cancel

IJava Applet "Window

Figure 172: Attach Job Order — New Window

8. Click [OK] to return to the Funding Sources — New window.
9. Click [OK] to return to the Funding tab of the Line Item Detail window.

10. From the menu, select File - Update to update the funding information.

Note: The PR must be saved to save the funding information.
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Editing a Job Order

PRweb users can edit job orders at the line item level. The System Administrator grants user

rights to manage funding information. If the user does not have these rights, funding and job order
information is read-only.

iy

o Line Item Detail - 0001

Figure 173: Line Item Detail — <Line Item Number>— Funding Tab

1. Double-click an existing funding source.
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The Funding Sources window opens.

& Funding Sources - New X

Funding Sources

Murmber: ||:||:||31 Description: |Tnnlhnxes
Total Eztimated Cost: |$EI,5IIIEI.IIIEI
Fund Strip My I Edit. . I Manage_._l

IT-'5B?555555555555555555555555&.f T T e T ¥ ¥ 7 T BEEEEEEEEREEEEEEEEEEEEE!

Funded Amaunt: IEI,SI:II:I.I:II:I Fund &CREM: I

100.0 9,500.00

Total Quantity: I'IDI:I.IZI Total Amount: IEI,SDEI.DEI Delete |

Ok | Cancel |

|-_|a\-'a Applet wWindow

Figure 174: Funding Sources Window

2. Highlight the desired job order and click the [Edit] button next to the Job Order table.
The Attach Job Order — <Job Order Name> window opens.

& Attach Job Order - CODD39491

Job Crder: ICI:II:II:ISEMEI‘I

Funded Amourt:  [3,500.00

Funced Quartity: |1 o0.0a

Ok Cancel

|Java Applet Window

Figure 175: Attach Job Order - <Job Order Name> Window

3. Click the [Select] button.
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The Job Order Number Search window opens.

Job Order Mumber Search

Search Criteria

IE W Current Job Orders Only
e | Search melect Cancel
Job Order Mumber Fundz Expiration Date
Java applet \Window

Figure 176: Job Order Number Search Window

4. Enter Search Criteria, and click the [Search] button.

5. Highlight a job order number and click the [Select] button.

The Attach Job Order - <Job Order Name> window opens with the new job order

number displayed in the Job Order field.

& Attach Job Order - COD039491

Jab Order: IHP.M 0

Funded Amourt:  [9,500.00

Funded Quartity: |1 00.00

Ok Cancel

|Java Applet "Window

Figure 177: Attach Job Order - <Job Order Name> Window

6. Click [OK] to return to the Funding Sources window.

7. Click [OK] to return to the Funding tab of the Line Item Detail window.

8. From the menu, select File - Update to update the funding information.

Note: The PR must be saved to save the funding information.
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Deleting a Job Order

PRweb users can delete job orders at the line item level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding and job order
information is read-only.

Line Item Detail - 0001

Figure 178: Line Item Detail - <Line Item Number > Funding Tab

1. Double-click an existing funding source.
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The Funding Sources window opens.

& Funding Sources ﬂ

Funding Sources

Murmber: ||:||:||31 Description: |Tnnlhnxes
Total Eztimated Cost: |$EI,5IIIEI.IIIEI
Fund Strip My I Edit. . I Manage_._l

IT-'5B?555555555555555555555555&.f T T e T ¥ ¥ 7 T BEEEEEEEEREEEEEEEEEEEEE!

Funded Amaunt: IEI,SI:II:I.I:II:I Fund &CREM: I
Add... |

KP&101 10-May-2003 100.0 9,300.00 p—

Total Quantity: I'IDI:I.IZI Total Amount: IEI,SDEI.DEI Delete |

Ok | Cancel |

|-_|a\-'a Applet wWindow

Figure 179: Funding Sources Window

2. Highlight a job order and click the [Delete] button next to the Job Order table.

3. Click the [Yes] button in the Confirmation window.

The Funding Sources window displays with the job order deleted from the table.

4. Click [OK] to return to the Funding tab of the Line Item Detail window.

Note: The PR must be saved to save the funding information.
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Updating the Purchase Request with a Line Item

PRweb users can update the PR with a line item once it has been created or modified. An updated
PR reflects any changes made to the line item since the last update. To update the PR with a line
item, select the File > Update from the Line Item Detail menu. Updating the PR with a line
item returns the user to the PR window.

Note: Updating and saving are two separate functions. A PR that has been updated with a line
item needs to be saved in order to save the PR in its updated status.

Creating a New Subcontract Line Item

The process for creating a Subcontract Line Item (SubCLIN) is similar to the creation of a
Contract Line Item (CLIN), however, there are a few differences. For example, if you have a
Priced CLIN, the CLIN Type defaults to Info Only in accordance with the Defense Federal
Acquisition Regulations (DFARS).

1. Open an existing PR.
2. Highlight a CLIN from the Line Item tab of the Purchase Request window.

3. From the menu, select Line Item - New = SubCLIN.
The Line Item Detail — New window opens with the Detail tab displayed.

The line item detail header displays at the top of the Line Item form and is visible from every
tab of the Line Item Detail — New window.
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i Line Item Detail - New = e

000101 I

L HEeed S e

Figure 180: Line Item Detail — New — Detail Tab

Note: Since creating a SubCLIN is similar to creating a CLIN, refer to “Creating a New Line
Item” in this chapter, to learn how to create a CLIN.

4. From the menu, select File 2 Update.

Acquiline PRweb v2.3 155 July 29, 2002
Functional User’s Guide



Chapter 6: Line Item

The SubCLIN displays as part of CLIN “0001".

i Purchasze Request - 123Train [_ (O] =]
File  Line Item

Description Purchase Reguest Mumber
Purchase ITraining |123Train
Requeat Requistion Date DFAS Prionty Rating | Priarnty
| 06-5ep-2000 | |
Main Form ~ Line item | Contracts | Add Data |
Total Funding |$2D,DDD_DD Contract Level Funding  [l=y |
* alves may he mumded for digolay gurposes.
Bl o001 Training 20 10,000.00 $20.000.00

000101 Training SubCLIM

Total Cost: [$20,000.00

|Waming: Applet Window

Figure 181: Purchase Request — <Purchase Request Number>— Line Item Tab
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Shipping Tab
The Shipping tab allows the PRweb user to identify the Shipping Address, Free On Board

(F.0.B.), Additional Markings, Charge Shipping To, Hazardous Material (HAZMAT)
Requirements and Shipping Mode.

i Line Item Detail - New

A Carriers Termingl, P of E - =

Figure 182: Line Item Detail — New — Shipping Tab

1. To enter a shipping address, click the [Select] button next to the Address field.

The Address field allows the PRweb user to search for a specific address from the PD*
database.
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The Ship to Contact Search window opens.

Ship To Contact Search

Search Criteria Search By

IE ' Code = Organization M ame

¢ Contact Mame  © Phone Mumber
Search | Selerf | Cancel | £ State " Zip Code
Contact | Code | Organization | City | State | Zip Code PH

| 3

|Warning: Applet Windaw

Figure 183: Ship To Contact Search Window

2. Enter Search Criteria, and click the [Search] button.

Note: For more information on searches, refer to “Search Function” section in Chapter 2:
PRweb Desktop.

3. Highlight the desired shipping address.

4. Click the [Select] button.
The Shipping tab displays the selected shipping address in the Address field.

5. Ifa PD? user adds multiple delivery information to a PR and return routes that PR to PRweb,
PRweb will not display the Shipping Address field. To see a summary of the multiple
delivery information, click on the [Multiple Deliveries] button located on the Detail tab of
the PR. PRweb displays the multiple delivery information including the ship to address
information in a summary format that is read-only.
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i Line Item Detail - 0001 = e

oot Chock ‘Wheel, Painted

Figure 184: Line Item Detail — 0001 — Shipping Tab

6. To enter Free On Board instructions, select the desired item from the F.O.B. drop-down list
box.

7. Enter any additional markings and specifications for shipping in the Additional Markings
field.

This field holds up to 60 characters.

8.  Enter shipping charge information in the Charge Shipping To field.
This field holds up to 40 characters.

9. Enter Hazardous Materials (HAZMAT) information in the HAZMAT field.
This field holds up to four characters.

10. To enter the mode of shipping, click the [Select] button next to the Shipping Mode field.

The Shipping Mode field allows the PRweb user to search for the shipping mode that is
required for the material being shipped.
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The Shipping Mode Search window opens.

Shipping Mode Search
Search Criteria Search By
IE &+ Code " Description
Search | Selewt | Cancel |
Code | D ezcription

|Warning: Applet \Window

Figure 185: Shipping Mode Search Window

11. Enter Search Criteria, and click the [Search] button.

Note:  For more information on searches, refer to “Search Function” section in Chapter 2:
PRweb Desktop.

12. Highlight the desired shipping mode.

13. Click the [Select] button.
The Shipping tab displays with the selected shipping mode in the Shipping Mode field.
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Local Info Tab

The Local Info tab allows the PRweb user to view, refresh, and edit line item local fields of a PR.
The PD? System Administrator determines the line item local info fields that are displayed on the
Local Info tab. Refreshing the Local Info tab allows the user to update the line item local fields
with the latest changes made by the PD* System Administrator. Clicking the [Refresh] button for
a line item updates all local info configurations for all line items on the PR. When the Local Info
is refreshed, any existing data in the fields remain, only the labels of the fields change. If the new
configuration has deleted fields from the old configuration, they are not displayed. If there have
been no updates made in PD?, the fields remain the same.

i Line Item Detail - 0001 = e

0002

Figure 186: Line Item Detail — New — Local Info Tab

1. Click on the [Refresh] button to refresh the line item local fields to the most current
configuration set by the PD? System Administrator.

2. Enter line item local information in the appropiate fields.
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Copying a Line Item

1. From the Purchase Request window, click on the Line Item to be copied.

2. From the menu, select Line Item > Copy.
The Line Item tab is updated with the copied Line Item.

i Purchase Request - New

=13l x|

Mewy
FEdit...

Delete

=Cription
cumentation Test

Purchaze Reguest Mumber
{DOCo01

Pricrity

l:luisitiu:un [Date DPAS Prarity B ating
ul-2002 | |

hsin Form  Line lem | Cu:untractsl A Data

Total Funding: |$1 0,000.00

Contract Level Funding Mare... |

* Falyes say pe munded for oisolay purposes.

Mumber

0o

Unit Cost Tatal Cost *

100.00 $10,000.00

Unit of lzzue

[(luantity
100.0

Dezcription

Total Cost: [$10,000.00

‘arning: Applet Yindow

Figure 187: Purchase Request - <Purchase Request Number> — Line Item Tab

Note:

Line Items cannot be copied on PR Modifications. For more information on PR
Modifications, refer to Chapter 5: PR Modifications.
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Chapter 7: Attachments

PRweb users may attach external files to the PR.
The creation of an attachment facilitates the
completion of a Requirements Package. For
example, a PRweb user can attach a Statement of
Work document to a PR or PR Modification and
send both objects to the Contracting Office. The
PRweb user may add, view and remove any Object

Linking and Embedding (OLE) compatible objects.

Adding an Attachment

In This Chapter...

Using the Attachments function
described in this chapter, you can:

e Add an attachment

e View an attachment

e Remove an attachment

PRweb users may attach any OLE compatible object to the PR.

To attach an OLE compatible object:
1. From the PRweb user’s desktop, open a PR.

2. From the menu, select File > Attachments.

The File Attachments window opens.

File Attachments Ei

Attached Documents

add. |

S

Erermove

i

Cloze

Drescription:

|'W'arning: Applet Window

Figure 188: File Attachments Window
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3. Click the [Add] button.

The New Attachment window opens.

Mew Attachment

Filename: I

Description:

Cancel |

|Warning: Applet Window

Figure 189: New Attachment Window

4. Enter the name of the file to be attached in the Filename field.

Note: The filename does not need to be the actual name of the object being attached. The
filename displays for reference purposes. Users should include the extension of the
object they are attaching at the end of the filename. For example, if a Statement of Work
created in Microsoft Word is attached, the filename should be in the form “SOW.doc”.
In this case, the file’s extension is “.doc.”

5. Enter a description in the Description field.

6. Click the [Select File] button to continue.
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The Upload File window opens as a new Web browser window.

/3 Upload File - Microsoft Internet Explorer

J File  Edit Wiew Favorites Tools Help |
(SO > R A B = S Ea . B2 R
Elack: Eanward Stop  FRefresh  Home Search Favortes  History b ail Frirt
J Address I@ 7383211 2150600ede0__ 1418fcf300f0d2d0d2_ Ob02ffe9f312f1 e 2dboedlc2aa9eB 590884 7d7 8664 3130441521161 5383f0302j 6> Go
J Links &]Acquiline &) Customize Links &7 Free Hotmail &7 Windows
Select file to attach:
f Browse... | Attach |
Mote: PEaweb allows wou to uplead any file on vour desktop, However, we strongly recommend that vou attach
documents that can be interpreted by the desktop software used by your Contracting Office and other PEsweb users.
Wicrosoft Office® documents are preferred.
|&] Done ’_’_|O Internet 4
Figure 190: Upload File Window
7. From the PRweb Attach File window, click the [Browse] button.
The Choose file window opens.
Chooze file |

8.

Laak. jn: I ty Computer

= &8 == E

= e u:u.n "waahoo' [E:]
=2 ¢ on "wahoo' [F:]
=2 amz(G:)

<] |

File narme: I

i
Open I
j Cancel |

Files of type: | A1l Files (%)

Figure 191: Choose File Window

From the Choose File window, locate the desired object to attach to the PR.
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9. Highlight the object.

10. Click the [Open] button in the Choose File window.
The Upload File window opens.

11. Click the [Attach] button to attach the object to the PR.

12. Click [OK].

The Upload Complete window opens with the “Successful Attachment” message.

3 Upload Result - Microsoft Internet E xplorer

Figure 192: Upload Complete Window

13. Close the window to return to the File Attachments window.
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The new attachment is displayed in the Attached Documents table with its description
displayed in the Description field.

File Attachments

| Attached Documents Add...

Wi,

i

Remove

Cloze

D'escription

Statement of ‘wark,

|Warning: Applet window

Figure 193: File Attachments Window

14. Click the [Close] button to return to the PR.

15. From the menu, select File = Save to save the attachment.
Viewing an Attachment

PRweb users may view objects that have been attached to the PR.

To view an attachment:

1.  From the PRweb user’s desktop, open a PR.

2. From the menu, select File 2> Attachments.
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The File Attachments window opens.

File Attachments

| Attached Documents Add.

Wig. ..

Femove

i

Cloze

Dezcription

Statement of ‘wark,

|Warning: Applet window

Figure 194: File Attachments Window

3. Highlight an attachment and click the [View] button.

The Viewing Instructions window opens.

Yiewing Inztructions

bicrozaft Office, plain text and HTML documents and
JPEG and Bitmap images will be autamatically
dizplayed in a new browser window,

[ order to vies all other attachments, vou most;

1. Save the downloaded file to a tempaorary direchan
2. Rename the file ta its onginal name
3. Open the file with the appropriate application

Click. OF. to continue.

(] Cancel

¥ always view attachment instructions.

|'W'arning: Applet "Window

Figure 195: Viewing Instructions Window

4. Read the Viewing Instructions and click [OK].
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Note: If changes were made to the attachment, the user must remove the original object and re-
attach the updated object.

Removing an Attachment
PRweb users may remove attachments from a PR.
To remove an attachment:
1. From the PRweb user’s desktop, open an existing PR with an attachment.

2. From the menu, select File > Attachments.

The File Attachments window opens.

File Attachments E3

Attached Documents Add

Wigw, ..

Remove

il

Cloze

Drezcription:

Statement of *Work,

|'W'arning: Applet wWindow

Figure 196: File Attachments Window

3. From the File Attachments window, highlight the desired attachment and click the [Remove]
button.

4. Click the [Close] button to return to the PR.

5. From the menu, select File — Save to save the attachment.

Note: An attachment on a PR Modification that was pulled forward from the conform copy can
not be removed in PRweb. Only attachments that were added to the PR Modification can

be removed. The attachments pulled forward from the conform copy can be removed in
PD>.
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Chapter 8: DD254

In This Chapter...

The DD254 menu option allows the PRweb user Using the function described in this
to add a contract Security Classification chapter, you can:
Specification (DD254) to the PR.

e Add a security classification
specification (DD254) to the PR

To add a DD254 to a PR:

1. From the PRweb user’s desktop, open an existing PR.

2. From the menu, select File - DD254.
The DD254 window opens. This window contains six tabs:

Items 1-5
Items 6-9
Items 10-11
Items 12-13
Items 14-15
Items 16-17

1 DD254 - 123Train M= 3
File

ftems 1 -5 | ItemSE-Ell ftems 10 - 11 | fems12 - 13 | Item314-15| ﬂem318-1?|

DEPARTMEMT OF DEFEMNSE la. FACILITY CLEARAMCE REQUIRED
COMTRACT SECURITY CLASSIFICATION SPECIFICATION
[The requirements of the Dol Industrial Security Manual b, LEWEL OF SAFEGUARDING REQUIRED
apply to all security aspects of this effart.) I
2. THIS SPECIFICATION |5 FOR: [complete az applicable) | 3. THIS SPECIFICATION 15: [complete as applicable)
" a PRIME COMTRACT NUMBER * 3 DRIGIMAL [Complete date in all cases)
I Diate: |28-Sep-2DDEI
b SUBCONTEACT NUMEER " b. REVISION [Supercedes all previous specifications)

Few. #: I Dhate: I

& ¢ SOLICITATION OF OTHER MUMBER  Due Date " . FINAL [Complete ltem 5 in all cases)

[123Train | Date: |

4,15 THIS & FOLLOW OM COMTRACT?  Yes € No  If yes, complete the following:

Clazsified material received or generated under I [Preceding Contract Mumber] iz transfered to
thiz fallaw-on contract.

5. 1S THIS & FINAL DD FORM 2547 “ Yes O Mo |f yes, complete the following:
I rezponze to the contractor's reguest dated I retention of the identified clazsification material iz
authorized for the period of: | through |

|Warning: Applet Window

Figure 197: DD254 - <Purchase Request Number> Window

AcquiLine PRweb v2.3 170 July 29, 2002
Functional User’s Guide



Chapter 8: DD254

3. Enter the appropriate information on each tab to complete the DD254.

4. From the menu, select File = Update to update the PR with the DD254.
Updating the PR with a DD254 form closes the DD254 window.

Note:  Updating and saving are two separate functions. A PR that has been updated with a
DD254 needs to be saved in order to save the PR in its updated status.
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Chapter 9: Workflow

Routing .
In This Chapter...
The PRweb module supports the electronic routing : :
and approval of PRs and PR Mods within PRweb and Usmg the Workﬂow functions
between PRweb users and PD? users. Members of described in this chapter, you can:
secu.r;:cy groups that olnly have roultmghacces; to e Route a PR or PR Mod by
specific routing templates may only choose from creating a custom routing sheet
those templates to which they have access when
routing. PRweb users without restricted security * Approve a PR or PR Mod
access can create new routing sheets, edit existing e View approval history
routing sheets and create route templates to facilitate
the electronic review and approval process.
The user must select a PD? user in order to route a PR. However, a PR Mod is automatically
routed to the PD” user that owns the conform copy of the base PR
Creating a Custom Routing Sheet
Only users with custom routing privileges may create custom routing sheets. Users have custom
routing privileges if they are not a security group member or are a member of a security group that
has custom routing privileges. Users with custom routing privileges may create routing sheets by
using any combination of usernames, group names or template users.
Creating a Custom Routing Sheet — All Users
To create a custom routing sheet using the A/l Users option:
1. From the PRweb user’s desktop, highlight a PR or PR Mod.
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2. From the menu, select Purchase Request 2> Route.

The Routing Sheet - <Purchase Request Number> window opens.

& Routing Sheet - PRO101 _ x|

Routing Sheet

View Routees By : (* i

™ Group Templates
" Template ;I
Foute Ta
30 CHARACTERS USER D 0 - Michels Way
ACCERPTOR FOUR
ACCEPTOR QOME IE
ACCEPTOR THREE
ACCEPTOR TWio E

ADAK ANDREMNS
ALEX DL SCHEFER
Al EX SCHEFER

select Al I

Route to PD? Lset: I Select... |
Siewy Groups... | Ok | Cancel |

I.Java Applet wWindow

Figure 198: Routing Sheet - <Purchase Request Number> Window

Note: The All Users radio button is automatically selected by default.

3. From the Routing Sheet window, select the View Routees By radio button.

Note: The User list box displays all available users to add to the routing sheet. As users are
added to the routing sheet their username displays in the order they were selected in the
Route To list box. Users must be placed in routing order on the routing sheet. The user
in the zero position is the creator of the PR and cannot be deleted from the routing sheet.

4. Select routees for the new routing sheet by highlighting desired users from the User list box
and clicking the [ p ] button.

Note: Routees may be removed from the routing sheet by highlighting the desired user from the
Route To list box and clicking the [ 4 ] button.
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5. Click the [Select] button next to the Route to PD? User field.
The Select PD’ User window opens.

Select PD? User

FPD Uszer?
Drarminic Joel

Sarah Jopce
Sywstem Administrator

Select { Cancel

|Warning: Applet Window

Figure 199: Select PD’ User Window

Note:  When the user clicks the [Select] button next to the Route to PD? User field on a route
sheet for a PR Mod, a message displays that indicates that the PR Mod will be routed to
the PD? user that owns the conform copy of the PR.

6. Highlight the appropriate PD? user.

7. Click the [Select] button.
The PD’ user selected displays in the Route to PD? User field on the routing sheet.

8. Click [OK] to initiate the routing sheet.

Note: Once a new routing sheet has been created and saved, routing initiates automatically.
The creator of a PR does not need to approve the PR to begin the routing process.

Create a Route Sheet — Groups

Selecting the Groups radio button displays all organizational groups created by the PRweb
System Administrator.

To create a route sheet using the Groups criteria:
1. From the PRweb user’s desktop, highlight a PR.

2. From the menu, select Purchase Request — Route.
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3.

The Routing Sheet - <Purchase Request Number> window opens.

Select the Group radio button.

# rRouting Sheet - PRO102

Routing Sheet

View Routees By: | Al Users

i Template

Templates

Graup ’_*

Alex grp
CUSTOMER
DFAS

Dena
Dena's

EC

ERIK

-

Select Al I

Foute Ta

0 - Michelle Wiy

Route to PD? Uset: I

Select... |

Yiewy Groups. .. |

ok |

Cancel I

I.Java Applet Windaw

Figure 200: Routing Sheet - <Purchase Request Number> Window

4. Click the [View Groups] button to view members of a group.
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The Groups (Read Only) window displays.

i Groups (Read Only) " =10] x|

Drescription Opeh... |
Alex arp Alew'z Group
CHICEEMWS Just chickens
CUSTOMER Custarmer for PRweb Creation
DFAS DFaS PAyMENT OFFICE GROUP
Denat Dena's Fun Group 2
Dena's Fun Group
EG Ellen's Routees
ERIE. Erik's group =
ERIK.2 Erik's second group
ErmwinZ Erwin's Second Group
FOR WIEW To wiew the PRz of pour subs. -
| I P Cloze

|'-.-'-.-'arning: Applet Window

Figure 201: Groups (Read Only) Window

5. Highlight the desired group and click the [Open] button to view group members.

Group - Alex grp (Read Only) |

I arne; I.ﬂ'-.le:-: ap

Dezcriptian: |ﬂ|e:-:'s Group

Members | Managersl Rigf‘rtSl

Man-tembers * hembers

30 CHARACTERS USER 1D ACCEFTOR TWwW0
ACCEPTOR FOUR E ACCEPTOR THREE
ACCEPTOR OME ADAM AMDREWS
ACQUSERZ1 ANDREW
AQUAFINA ALE¥ DL SCHEFER
B W atzon E ALEY SCHEFER
B Wwatson JENNIFER ROSS
B ‘“wWatzan
BADILLO

Cloze |

Warning: Applet Window

Figure 202: Group - <Name> (Read Only) Window

6. Click the [Close] button to return to the Groups (Read Only) window.

7. Click the [Close] button to return to the Routing Sheet <Purchase Request Number>
window.
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8. Select group(s) for the new routing sheet by highlighting a desired group from the Group list
box and clicking the [ p ] button.

Note:  All groups that the PRweb System Administrator created displays in the Group list box.
As groups are added to the routing sheet their group name displays in the order they were
selected in the Route To list box. Groups must be placed in routing order on the routing
sheet. The user in the zero position is the creator of the PR and cannot be deleted from

the routing sheet.

Note:  Groups may be removed from the routing sheet by highlighting the desired group from
the Route To list box and clicking the [ 4 ] button.

9. Click the [Select] button next to the Route to PD’ User field.
The Select PD’ User window opens.

Select PDZ User

FD Usger2

Drarminic Joel
Sarah Jopce
Sywstem Administrator

Selent

|Warning: Applet Window

Figure 203: Select PD’ User Window

Note:  When the user clicks the [Select] button next to the Route to PD? User ficld on a route
sheet for a PR Mod, a message displays that indicates that the PR Mod will be routed to
the PD? user that owns the conform copy of the PR.

10. Highlight the appropriate Contracting Officer.

11. Click the [Select] button.
The PD’ user selected displays in the Route to PD? User field on the routing sheet.

12. Click [OK] to initiate the routing sheet.

Create Routing Sheet — Template

PRweb employs the use of templates to facilitate the routing process. Users with appropriate
security access can create individual route templates. Selecting the Template radio button
activates the Templates drop-down list box and allows the user to display global and individual
templates. The user can then select the desired template.

AcquiLine PRweb v2.3 177 July 29, 2002
Functional User’s Guide



Chapter 9: Workflow

To create a route sheet using the Templates criteria:
1. From the PRweb user’s desktop, highlight a PR.

2. From the menu, select Purchase Request 2> Route.

The Routing Sheet - <Purchase Request Number> window opens.

3. Select the Template radio button.

# Routing Sheet - PRO103 x|

Routing Sheet

View Routees By : { Al Users

Templates

I[Nu:une] ;I

Tetmplate Route Ta
0 - Michelle YWary

Select Al I

Raute to PD? User: | Select... |
Wiewy Groups... | 034 | Cancel |

I.Java Applet "Window

Figure 204: Routing Sheet - <Purchase Request Number> Window

4. Select the desired route template from the Templates drop-down list box.

5. Select routees for the new routing sheet by highlighting the desired members from the
Template list box and clicking the [ p ] button. Click the [Select All] button below the

Template list box to select all members of the template.

Note: Routees may be removed from the routing sheet by highlighting the desired routee from
the Route To list box and clicking the [ 4 ] button.

6. Click the [Select] button next to the Route to PD? User field.
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The Select PD’ User window opens.

Select PDZ User

FPD Uszer?
Drarminic Joel

Sarah Jopce
Sywstem Administrator

Select { Cancel

|Warning: Applet Window

Figure 205: Select PD’ User Window

Note:  When the user clicks the [Select] button next to the Route to PD? User ficld on a route
sheet for a PR Mod, a message displays that indicates that the PR Mod will be routed to
the PD? user that owns the conform copy of the PR.

7. Highlight the appropriate Contracting Officer.

8. Click the [Select] button.
The PD’ user selected displays in the Route to PD? User field on the routing sheet.

9. Click [OK] to initiate the routing sheet.

Editing a Routing Sheet

PRweb users with appropriate security access may edit (add and remove users from) an existing
routing sheet.

To edit a routing sheet:

1.  From the PRweb user’s desktop, open a PR.

PRweb users can edit routing sheets for PRs that reside in their Inbox and Outbox.

2. From the menu, sclect File - Route.
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The Routing Sheet window opens.

Routing Sheet - 123 Train

Routing Sheet

View Routees By ™ AllUsers

" Group Templatez

" Template ;I

Uszer - Route Ta

123456758901 23456753901 2345 0-PEGGEY THOMPSOM
Ay MEHMERT

MY MEHMERT

AUSERTP
BALEY KUMINS

BaARBARA ALERT

BaREBARA BROCK ‘zl
BARBARA ERROR 2
BaRBARA LUSER A

Selech Al I

Route to POE User: I Calect |
Wiew Groups... | Cancel |

|Warning: Applet Window
Figure 206: Routing Sheet - <Purchase Request Number> Window

3. Select additional routees for the routing sheet by highlighting desired users or groups from the
User, Group, or Template list box, respectively, and clicking the [ ) ] button.

4. Remove routees from the routing sheet by highlighting desired users or groups from the
Route To list box and clicking the [ ¢ ] button.

Note: Edits must reflect the appropriate route sequence. For example, to add a routee before an
existing routee, remove the existing routee, add the new routee and then re-add the
original routee. The creator of the PR may not be removed from the routing sheet.

5. Change the PD* user designated to receive the PR in the Route to PD? User field if
necessary.

6. Click [OK] to save changes to the routing sheet.
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Creating a Non-Custom Routing Sheet

Users with non-custom routing privileges may create routing sheets based only on defined
templates. Users do not have custom routing privileges if they are members of security groups
that cannot custom route. These security groups can have one or more routing templates
associated with them. The PRweb System Administrator maintains security groups.

Creating Template Route Sheet by Selection

Users with non-custom routing privileges may be assigned to a security group with more than one
routing template associated with it. In this case the user may choose the routing template to route
a PR.

To create a routing sheet:

1. From the PRweb user’s desktop, highlight a PR.

2. From the menu, select Purchase Request 2> Route.

The Routing Sheet - <Purchase Request Number> window opens.

Routing Sheet - ABC123

Templates: [[Mone] |

Routees:

PD= Lszer:

Ok, Cancel

|Warning: Applet Window

Figure 207: Routing Sheet - <Purchase Request Number> Window

3. Select the desired route template from the Templates drop-down list box.

The members of the template display in the Routees list. The PD’ user associated with
the template displays in the PD’ User field.

4. Click [OK] to save the routing sheet.
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Approvals

Creating Template Route Sheet by Non-Selection

Users without custom routing privileges may be assigned to a security group with only one routing
template associated with it. In this case the PR is automatically routed when the user chooses to
route the PR.

To create a routing sheet:

1. From the PRweb user’s desktop, highlight a PR.

2. From the menu, select Purchase Request 2> Route.

The PR is routed automatically. The Information window opens.

Information

& Purchaze Request ABC123 haz been routed

succezsfully.

|'W'arning: Applet "Window

Figure 208: Information Window

3. Click [OK] to return to the PRweb desktop.

The PRweb module facilitates the electronic approval of PRs and PR Mods. When a PR or PR
Mod is received in a user’s Inbox, that user can review and approve the document, reject the
document, or designate contingent approval of the document.

Approving a Purchase Request or PR Mod

PRweb users may electronically approve a PR or PR Mod. An approved PR or PR Mod is
removed from the user’s desktop and continues on through the routing process to the next user
designated on the routing sheet.

To approve a PR or PR Mod:

1. From the user’s desktop, highlight the desired PR or PR Mod contained in the Inbox.

2. From the menu, select File > Approve.
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The Approval - <Purchase Request Number> window opens.

Approval - 123Train
Approval
Status:

Comments:

k. Cancel

|Warning: Applet WwWindow

Figure 209: Approval - <Purchase Request Number> Window

3. Select “approved” from the Status drop-down list box.

4. Enter comments in the Comments field, as necessary.

Note: The Comments, Approval Date, and Status display in the Approval History. For more
information regarding Approval History, refer to this chapter on “View Approval
History™.

5. Click [OK] to approve the PR.

The PR displays in the Inbox of the next user designated on the routing sheet. If there
are no more PRweb users on the routing sheet, the PR displays in the Inbox of the PD’
user designated on the routing sheet.

Note:  An e-mail alert is sent to all users on the routing sheet when a PR is marked “Rejected”
or “Contingent”. The e-mail contains the comments entered in the Approval window.

Rejecting a Purchase Request

PRweb users may reject a PR or PR Mod during the approval process. The rejected document
continues on through the routing process to the next user designated on the routing sheet. A copy
of the rejected document remains in the Rejecting Authority’s Inbox as a reminder that the user
has a rejected document that requires change, either by the user, the creator of the document or
another user on the routing sheet. The PR or PR Mod is not sent to PD* until it is fully approved.

To reject a PR or PR Mod:
1. From the user’s desktop, highlight the desired PR or PR Mod contained in the Inbox.

2. From the menu, select File > Approve.
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The Approval - <Purchase Request Number> window opens.

Approval - 123Train

Approval

Statuz:

Comrments:

aF. Cancel

|Warning: Applet twindow

Figure 210: Approval - <Purchase Request Number> Window

3. Select “rejected” from the Status drop-down list box.

4. Enter comments in the Comments field, as necessary.

Note: The Comments, Approval Date, and Status display in the Approval History. For more
information refer to this chapter on “View Approval History”.

5. Click [OK] to reject the PR or PR Mod.

The creator of the PR or PR Mod receives an e-mail alert. The document remains in the
Inbox of the rejecting authority. If there are no more PRweb users on the routing sheet, the
document remains in PRweb until the rejecting authority approves the PR. At that time, the
document displays in the Inbox of the PD” user designated on the routing sheet.

Note: An e-mail alert is sent to all users on the routing sheet when the document is marked
“Approved”, “Rejected” or “Contingent”.

Designating Contingent Approval of a Purchase Request

PRweb users may give contingent approval of a PR or PR Mod. Contingent approval of the
document does not stop the approval process. The doucment continues on through the routing
process to the next user designated on the routing sheet. A copy of the document remains in the
approving authority’s Inbox as a reminder that the user has a PR or PR Mod that needs to be
changed, either by the user, the creator of the document or another user on the routing sheet. The
document is not sent to PD* until it is fully approved.

To give contingent approval of a PR or PR Mod:
1. From the user’s desktop, highlight the desired PR or PR Mod contained in the Inbox.

2. From the menu, select File > Approve.
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The Approval - <Purchase Request Number> window opens.

Approval - 123Train

Approval

Statuz:

Comrments:

k. Cancel

|Warning: Applet Window

Figure 211: Approval - <Purchase Request Number> Window

3. Select “contingent” from the Status drop-down list box.

4. Enter comments as necessary in the Comments field.

Note: The Comments, Approval Date and Status display in the Approval History. For more
information regarding Approval History, refer to this chapter on “View Approval
History”.

5. Click [OK] to authorize contingent approval of a PR or PR Mod.

The creator of the PR or PR Mod receives an e-mail alert. The document remains in the
Inbox of the user who gave contingent approval of the document. If there are no more PRweb
users on the routing sheet, the document remains in PRweb until the contingent approver
approves the document. At that time, the document displays in the Inbox of the PD” user
designated on the routing sheet.

Note: An e-mail alert is sent to all users on the routing sheet when a document is marked
“Approved”, “Rejected” or “Contingent”.

View Approval History

PRweb users may view the Approval History of a PR or a PR Mod that currently resides on their
desktop. The Approval History displays the approval status and date for all users assigned to the
routing sheet and any comments that may have been included. The list displays in chronological

order with the most recent approver as the last entry. If the document is returned routed from PD’
the status shows as return routed.

To view Approval History:
1. From the user’s desktop, highlight a PR or PR Mod.

2. From the menu, select Purchase Request > View Approval History.
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The Approval History - <Purchase Request Number> window opens.

Approval History - VYiew Approval History x|

Approver | [ ate | Statuz | Commernts
DrfdshAbd MO 8 16-tap-20001  approved
ADUSERTOH 16-Map-2000  approved
ADUSERT1# 16-Map-20001  approved

anwebdy 3 [PDE] 16-tap-20071  return routed

Cloze |

|Warning: Appletindow

Figure 212: Approval History - <Purchase Request Number> Window

Note:  Using the Approval History is an effective way of determining the location of a given PR
or PR Mod.

3. Click the [Close] button to close the Approval History window.
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Chapter 10: Reports

PR Status Report In This Chapter...
PRweb users can generate PR status reports to Using the Reports function described
identify the procurement stage for a given in this chapter, you can:

requirement. The PRweb module directly
interfaces with PD? and pulls up-to-date
information for the requesting agent. The user can e  Generate pre-formatted Standard
view the PR Modification, milestone plan, Reports

solicitation, and award for a given requirement.

e View PR Status Reports

To generate a PR Status Report:

1. From the menu, select Purchase Request > PR Status Report.
The PR Status Report window opens.

Note: The PRweb, All, and Group(s) radio buttons on the PR Status Report window are
based on rights assigned to a user at the group or user level by the System Administrator
and may not display for every user.
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PR Status Report E3
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Figure 213: PR Status Report Window

Select the appropriate Search By radio button.

PR No.: The PR No. radio button allows the PRweb user to search by a specific purchase
request number. Users can enter the first character of the purchase request
number in the Search Criteria field, followed by the “%” sign, and all PRs
beginning with that character that also meet the other criteria designated in the
PR Status Report window display.

Desc.: The Desc. radio button allows the PRweb user to search by a specific PR
description. Users can enter the first character of the PR description in the
Search Criteria field, followed by the “%” sign, and all PRs beginning with
that character that also meet the other criteria designated display.

Select the appropriate Display radio button.

My PRs:  The My PRs radio button allows the user to display only PRs that were created
by the user and reside in PD?. PRs that are return routed from PD? do not
display.

PRweb: The PRweb radio button allows the user to display PRs that were created by any

PRweb user and reside in PD?. The PRweb radio button is visible only if the
user has rights.

All: The All radio button allows the user to display all PRs that reside in PD?
including PRs created in PRweb. The All radio button is visible only if the user
has rights.
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Group(s): The Group(s) radio button allows the user to display the PRs that reside in PD*
and were created by members of the group(s) she/he manages. The Group(s)
radio button enables a drop-down list box listing all the groups the user
manages. If the non-administrative user manages more than one group, the
drop-down list box includes the “All My Groups” option. The drop-down list
box is disabled if the user is the manager of only one group. The Group(s)
radio button and drop-down list box are not visible to a non-administrative user
that is not the manager of any groups.

4. Enter the Search Criteria followed by the universal search symbol (%).

Note:  For more information regarding the use of the Search Criteria field, refer to “Search
Function” section in Chapter 2: PRweb Desktop.

5. Enter a beginning date in the Begin Date field.

Entering a Begin Date further qualifies the search to find only those PRs that were created on
or after the entered date. Users can enter the date manually or utilize the Auto-Calendar
feature.

6. Enter an end date in the End Date field.

Entering an End Date further qualifies the search to find only those PRs that were created on
or before the entered date. Users can enter the date manually or utilize the Auto-Calendar
feature.

Note: Both the Begin Date and End Date fields are required.

7. Select the [Search] button to view the results of the search.
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8.

Query results display in the query box on the left side of the window.

x
B~ Querny Resul Search Ciiteria Search By Dizplay
S| 7001 % MyPRz (" PRweb
I%I--:award Begin Date End Date & PR No. Al
B VERERLOZC000N || a5 unzonz TR [15u-zooz | (TR
- 5] Solicitation I @ I @ £ Desc.
VECEB1-02-T-0010 Search |  Clear |  Clos= |
Ea Milestone Flan
+El Ton PR Number.  [T007
Creation Drate: IDE£25£2DD2
Dezcription: Ione
Requestor FD= Document Dwner
ERIK BADILLO |Erik B adillo
erk_g_badillof@ams. com Fuichase Ackion
ISmaII Purchase
Total Est. Cost Tatal Funded Amt. Priciity
[#10.000 [#10.000 [
Line Items
| # | Desc, | Drelivery [ ate | [ty Tob, Est, Cost F
[I] 15-Jul-2002 100.0 $10,000.00
KN | 3

Surmmarny Report... |

|Warning: Applet Window

Figure 214: PR Status Report Window

Double-click a PR beneath the Query Results icon.

Note:

Each result contains a parent PR folder with three associated folders: Award, Solicitation,

and Milestone Plan.

9.

information.

Open a sub-directory folder and highlight the associated object number to display status

Note:

Selected object information displays in the lower right corner of the PR Status Report
window. Only sub-directory folders with a plus sign (+) next to them can be opened.

10. Click the [Summary Report] button to view the Summary Report window.
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The Summary Report window opens.

x
FR Mumber Appry. Cancl | Salicitation Released Award Feleazed Funded Anount($]

Approved M WELCEBT-02-T-0010 WELCERT-02-C-0001 $10,000.00

Cloze |

warning: Applet Window

Figure 215: Summary Report Window

Note: The Summary Report window provides a snap-shot of the procurement actions for all
PRs displayed in the PR status query results.

Note: For a quick way to search a list, refer to the ‘Searching Within A List” section in Chapter
2: PRweb Desktop.

11. Click the [Close] button to return to the PR Status Report window.
12. Click the [Clear] button to clear the criteria and create another query.

13. Click the [Close] button.
Standard Reports

PRweb users can generate pre-formatted reports, pulling information directly from the PRweb and
PD’ databases. PRweb users can request custom reports from American Management Systems
(AMS). Currently, there are three standard reports: PRweb Locator Report, View Canceled PR
Status Report and View Open PR Status.

AcquiLine PRweb v2.3 191 July 29, 2002
Functional User’s Guide



Chapter 10: Reports

PRweb Locator Report
1. From the menu, select Purchase Request - Standard Reports.

The Standard Reports window opens.

Standard Reports x|

Select Report

M ame | Dezcription
PRweh Locator R eport Location of PR= in route for five or more elapsed days.

Yiews Canceled PR Statuz Report Report on canceled PR
Yiew Open PR Statuz Report Repart on location of non-approved PRz

K1
Sort By
| =

Enter the new value far;

I Enter |

Parameter Walle

] Cloze

Warning: Applet Window

Figure 216: Standard Reports Window

2. Double-click the PRweb Locator Report from the Select Report panel.

Note: The PRweb Locator Report provides a list of all PRs that have been in PRweb for a
minimum of five days. The report displays associated information for each of these PRs
(i.e., PR number, description, creator, and creation date) including the total of days in
route and in PRweb, the name of the user and/or group who had the PR the longest and
number of days in the longest station. The report also displays the current station and

number of days in that station.

3. Choose the desired Sort By option from the drop-down list box.

The Sort By drop-down list box allows the PRweb user to sort the information in the report
by the text in any data column that is available in the Sort By drop-down list box.
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Standard Reports x|

Select Report
M ame Dezcrption

FPHweb Locator Bepart Location of PR in route for five or more elapser

Yiew Canceled PR Statuz Report Repoart on canceled PRz

Yiew Open PR Statuz Report Repart on location of non-approved PRz -
0 | 3
Sort By
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k. Cloze
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Figure 217: Standard Reports Window

4. Click [OK] to generate the Report.
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The PRweb Locator Report window opens.

PRweb Locator Report
PR Numl:u| Descriptin| Creataor | Ereatiunq Station |:|f| ﬂu:ufDa_I,Is| Eurrent5t| ﬂu:ufDa_I,Is| Tatal Da
2N 234kez Copy of be: uzer? 2007-04-31 uzerd 9 Lzerd 9 9
BE7Rtest  Copy of ke uzer? 2007-04-31 uzerd 9 Lzerd 9 9
DABT43-C DABT43-LC dwvammino 2001-04-11 usery 14 LIZEMY 14 14
SPA3I0-E WAIT 4-27 ADuzerl#t 2001-04-1 ADuserzf 22 ADusersft 22 22
SPAII0N-T 2WwAIT 4- ADuzerl# 2001-04-10 ADuser2f 21 ADuzer2f 21 21
report] report] Lzerz 2001-04-1! uzers 15 LIZErs 15 19
report? report? LIzEIz 2007-04-1! Lzerm 15 LIZEIm 15 15
reportd reportd LIZEr 2001-04-2 uzerg 15 LIEErg 15 15
reporth reporth Lz 2007-04-2 uzerg 15 Lizerg 15 15
reports reports LIz 2007-04-2 uzerg 15 LizErg 15 15
test03 test03 |lzerB 2001-04-17 Userd, 25 |lzerd, 25 25
testB /3 testing e-r uzerd 2007-04-31 Lzerf 9 Lizerh 9 9
testPRVEY Copy of te: uger? 2001 -05-0 uzerd g uzerh g g
kestraute]  kest routing Lserg 2007-04-21 [testard] 13 [testard] 13 13
| 3

&% | < Erevious

[Netarz Frint HTHL Report
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PR Number

Description

Creator
Creation Date

Station of Longest Stay

# of Days in Longest Station

Current Station

# of Days in Current Station

Figure 218: PRweb Locator Report

The number designated in the Purchase Request
Number field of the PR.

The full description contained in the Description
field.

The creator of the PR.
The creation date of the PR.

The name of the user who had the PR in his/her Inbox
the longest.

The number of days that the PR was in the longest
station user’s /nbox.

The name of the user who currently has the PR in
his/her Inbox.

The number of days that the PR has been in the user’s
or group’s Inbox.

Total Days in Route The total number of days, from the route date to the
report generation date, that the PR has been in PRweb.
Note: The user can adjust the width of each column by clicking on the line separating each

column and holding down the left mouse button and dragging the cursor to the right or

left.
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Print HTML Report:

Details:

Previous:

<<:

When a user clicks the [Print HTML Report] button the Custom
Reports — Internet Explorer window opens allowing the user to
print the PRweb Locator Report.

The [Details] button allows the user to view details associated with a
PR. The [Details] button is enabled only if there are additional
details associated with the report currently displayed on the screen.
A user selects a row from report in the window and clicks the
[Details] button to view the details.

The [Previous] button allows the user to return to the previous
Standard Report window. The [Previous] button is enabled only if
there is any preceding information. A user selects the [Previous]
button to display the information previously viewed.

Press the [<<] button to return to the Standard Reports window.

5. Click the [Close] button to return to the Standard Reports window.
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View Canceled PR Status Report
The View Canceled PR Status report provides a list of all PRs created in PRweb that have been

canceled in PD?.
1. From the menu, select Purchase Request > Standard Reports.

The Standard Reports window opens.

Standard Reports x|

Select Report

M ame | Dezcrption
FPRweb Locator Report Location of PR in route for five or more elapzed days.

Yiew Canceled PR Status Report Report on canceled PRz
Yiew Open PR Status Report Repart on location of non-approved PR s

v

Sort By
| =l

Enter the new value far:

I Enter |

Walle

Parameter

k. Cloze

Warning: Applet Window

Figure 219: Standard Reports Window

2. Double-click the View Canceled PR Status from the Select Report panel.

The View Canceled PR Status Report provides a list of all PRs created in PRweb that

Note:
have been canceled in PD>.

3. Choose the desired Sort By option from the drop-down list box.

The Sort By drop-down list box allows the PRweb user to sort the information in the report
by the text in any data column that is available in the Sort By drop-down list box.
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Standard Reports
Select Report

M ame | Dezcription
PRweh Locatar Beport Location of PRz in route far mare than five days.

Yiew Canceled PR Statuz Beport Heport on canceled PRs
Yiew Open PR Status Report Report on location of non-approved PR

M
Sort By
|F'H Murnber =]

E nter the new walue far:
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BEGIM DATE 01,01 ,/2000
EMD_DATE 09/28/2000
ORIGINATOR 4
Ll 3

k. Cloze
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Figure 220: Standard Reports Window

4. Double-click the desired Parameter from the panel.

Note: The Parameter table allows the user to further define the search results. For example, if
a user wanted to view PRs created on a specific day, the user can select the
BEGIN_DATE and END_DATE parameter from the table and that date can be entered in
the Enter the new value for box. If the user changes the Parameter, the user must click

the [Enter] button for changes to take effect.

5. Click [OK] to generate the report.
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The View Canceled PR Status Report window opens.

Yiew Canceled PR 5Status Report
FR Mumber | Diezcription | Creation Datﬁi Criginator | Canceled Da1 Canceled By | k.0 Motes

canceled] canceled] 2001-05-14 ¢ bbtest 2001-0514 10 bbrd2d42
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canceled? canceled? 2001-05-14 10 bbtest 2001-0514 10 bbrd2da2

canceledd canceledd 2001-05-14 10 bbtest 2001-0514 10 bbrd2d42

canceledd canceledd 2001-05-14 10 bbtest 2001-0514 10 bbrd2da2

LI 3

% I < Breyious [retars s Frint HTHL Report

|Warning: Applet Window

Figure 221: View Canceled PR Status Window

Note: The user can adjust the width of each column by clicking on the line separating each
column and holding down the left mouse button and dragging the cursor to the right or
left.

Note: The user can click the [<<], [Previous], [Details], or [Print HTML Report] button to
aid in the report generation process.

6. Click the [Close] button to return to the Standard Reports window.

View Open PR Status Report

The View Open PR Status Report provides a list of all PRs currently in PRweb and their current
location.

1. From the menu, select Purchase Request - Standard Reports.
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The Standard Reports window opens.

Standard Reports x|

Select Report

M ame | Dezcrption
PRweb Locator Report Location of PR in route for five or more elapzed days.

Yiew Canceled PR Statuz Report Repoart on canceled PRz
Yiew Open PR Statuz Report Repart on location of non-approved PRz

1|
Sort By
| =l

Enter the new value far:

I Enter |

Parameter Walle

k. Cloze

Warning: Applet Window

Figure 222: Standard Reports Window

2. Double-click the View Open PR Status Report from the Select Report panel.

3. Choose the desired Sort By option from the drop-down list box.

The Sort By drop-down list box allows the PRweb user to sort the information in the report
by the text in any data column that is available in the Sort By drop-down list box.
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Standard Reports

Select Report
M ame | Dezcription

FRweb Locator Report Location of PRz in route for mare than five days.

Yiew Canceled PR Statug Report Report on canceled PR

Yiew Open PR Status Beport Feport on lozation of non-approved PRz

LI 5
Sort By

|Ereati-:nr'| Date =]

E nter the new walue far:

Parameter Walle
BEGIM DATE 01,01 ,/2000
EMD_DATE 09/28/2000
ORIGINATOR 4
Ll 3

k. Cloze

|'W'arning: Applet "Window

Figure 223: Standard Reports Window

4. Double-click the desired Parameter from the panel.

Note: The Parameter table allows the user to further define the search results. For example, if
a user wanted to view PRs created on a specific day, the user can select the
BEGIN_DATE and END_DATE parameter from the table and that date can be entered in
the Enter the new value for box. If the user changes the Parameter, the user must click
the [Enter] button for changes to take effect.

5. Click [OK] to generate the report.
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The View Open PR Status Report window opens.

Creation [ ate | Originiakor | FR Murnber | Description | Location | Skatusz 1=
2000-03-01 1E:Z shannon® irstall best iristall best shannon™ draft =
2000-03-01 16:2 zhannon® initialbuild initialbuild shannon® draft
2000-03-01 17:2 denabe 18 b by denaby 1 draft
2000-03-0512:2 denab1# b 975400 bee 945/00 denabyw 14 draft
2000-03-05 12:F parmuzer®l create OP&s Prionty Rz parmuzer] draft
2000-03-06 10:% denaby1# 9/6/2000 bee 946/2000 denabyw 14 draft
2000-09-06 12:C bhtest bbsugoested ve bbzugoested ve PamiGrpl pending appr
2000-09-06 121 bbtest bbviewsumz bbviewsumz bbhannah rejected
2000-09-06 121 bhtest bbviewsum? bbviewsumz bhgab pending appr
2000-03-06 137 bhbtest bbdontyview bbdontyview bbtest draft
2000-03-06 13:% bhtest bhview bibevig bhtest draft
2000-09-06 13:4 acquserd 123Train Training acquserd draft
2000-09-06 135 bbtest mijtestfarbb bbtestattachmer bbtest draft
2000-09-06 14:z bbtest bbaddinpd bbaddinpd bbtest draft
2000-09-06 15:1 bbtest bbaddzuggvend bbaddsuggvend bbbaley pending appr
2000-09-06 15:2 dvamminol# DD254 DD254 dvamminozt rejected
2000-09-06 15:2 dvammino] i DD254 DD254 dwammino3t pending appr
2000-03-06 15:2 michaelk, 00052000-0302: Code Revizsion & michaslk draift
2000-09-06 15:E tp 032303-2 Contract Level F tp draft
= 3
e | < Eresious [Nefare Print HTHL Report
|'W'arning: Applet wWindow

Figure 224: View Open PR Status Window

Note: The user can adjust the width of each column by clicking on the line separating each
column and holding down the left mouse button and dragging the cursor to the right or

left.

Note: The user can click the [<<], [Previous], [Details], or [Print HTML Report] button to
aid in the report generation process. Click the [Close] button to return to the Standard

Reports window.
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Chapter 11: Transfer Document

The Transfer Document functionality allows a PRweb In This Chapter...

user with managerial rights to transfer PRs and PR

Mods from one maqaged user to another managed Using the Transfer Document feature
user. The manager is able to transfer PRs and PR described in this chapter, you can:
Mods that reside in a managed user’s Drafts, Inbox,

and Quthox folders. However, PRs or PR Mods are e  Transfer ownership of PRs or
not available for document transfer if the document PR Mods from one manager
resides in the Inbox folder and has been routed to a user to another managed user

group.

Transfer a Document

To transfer a document:

=10l x|

File Preferences Purchase Request i
ERERCratts
I:l Inko
-] Duthox
I:l Archive

I mavayhlanager

|..|ava Applet WwWindow

Figure 225: PRweb Transfer Menu — Manager Desktop

1. From the menu, select Transfer = Transfer Documents.
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The Select Managed Users window opens.

Note: The Managed Users list box displays all the users that the current user manages.

i Select Managed Users : -0l x|

b anaged L zers

Transfer From

Llger Marme Full Mame El
omyxhoo Michielle Wiay |
gdonohue GEME DOMOHLE :
(LET RlvAAY 2

L] AN 3

nicole B W"atson Transier T
nicalep MIGOLE (-]
mwavhdanager hbids AR AGE El |
denavamminol# DEMNAWVAMMIMO TS

MHext... Cancel

Warning: Applet Window

Figure 226: Select Managed Users Window

2. Select Transfer From user by highlighting the user from the Managed Users list box and
clicking the [ p ] button.

The selected user’s Full Name displays in the Transfer From field as read-only.

Note: The selected user may be removed from the Transfer From field by clicking the [ € ]
button.

3. Select Transfer To user by highlighting the user from the Managed Users list box and
clicking the [ p ] button.

The selected user’s Full Name displays in the Transfer To field as read-only.

Note: The selected user may be removed from the Transfer To field by clicking the [ 4 ]
button.
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i Select Managed Users

amyxhoo Michelle Wiay
gdonohue GEME DOMNOHLUEB
(LET RlvAAY 2

nicole B Watzon
rmwayanager hl A AR AGE
denavamminol® DEMNAVAMBMIMNGO

Figure 227: Select Managed Users Window

4. Click the [Next] button to search for documents.

The Document Search window opens.
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: Document Search =101 x|
Search Criteria Search By
% & Document Number

" MSH
Search | "
" Description

Select Documents ta Tranzfer from rwayd

Dacument Type | Dacument Mumber Description RSN
Select
Selected Documents to Transfer to nicole
Document Type Document Mumber Description MNEMN
Femove |
0k Cancel |

WWarning: Applet Window

Figure 228: Document Search Window

5. Enter values in the Search Criteria field.
6. Select appropriate Search By radio button.
7. Click the [Search] button.

The search results display in the Select Documents to Transfer from <Transfer From
User Name> list box.

Note: Only PRs and PR Mods contained in the Transfer From user’s Drafis, Inbox, and
Outbox folders display. Documents contained in the Archive folder are not available for
transfer. In addition, PRs and PR Mods are not available for document transfer if the
document resides in the /nbox folder and has been routed to a group of users.
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: Document Search o ]

Search Criteria Search By

4

Select Documents ta Tranzfer from rwayd

" Document Mumber

" MSH
Search | "
" Description

Dacument Type | Dacument Mumhber Description [E=]
PR QANDES Test 0611102
PR Mod QADDES-0001 PR tod {Info CLIMPric
PR @ADDT0 Test 061 2102
PR Mod @ADOT2-0001 PR hod 0612502 A210-00-243-3349
PR QANDTE Test 061 2102 - Test S MYWO1-02-123-4567
PR QAD0S0 B 06 3702 1005-01-134-3621
Select
Selected Documents to Transfer to nicole
Document Type Document Mumber Description MNEMN
Femove |
0k Cancel |

WWarning: Applet Window

Figure 229: Document Search Window

8. Select the documents to be transferred by highlighting the desired documents from the Select
Documents to Transfer from <Transfer From User Name> list box and clicking the
[Select] button.

The selected documents displays in the Selected Documents to Transfer to <Transfer To
User Name> list box.

Note:

Multiple documents can be selected or removed by using the <Shift> or <Ctrl> keys.
Also, the manager is able to double-click a document to move it back and forth between
the Select Documents to Transfer from <Transfer From User Name> list box and the
Selected Documents to Transfer to <Transfer To User Name> list box.

Note:

A document may be removed from the Selected Documents to Transfer to <Transfer
To User Name> list box by highlighting the desired document and clicking the
[Remove] button. The removed document will display in the Select Documents to
Transfer from <Transfer From User Name> list box.

Note:

Documents that display in the Selected Documents to Transfer to <Transfer To User
Name> list box remain, unless removed. Thus, the manager is able to perform multiple
searches in order to select documents.
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: Document Search o ]

Search Criteria Search By

4 * Document Mumber

" MSH
Search | "
" Description

Select Documents ta Tranzfer from rwayd

Dacument Type | Dacument Mumhber Description | [E=] Il
PR MAAAWAAAANAY PR 052002-05 1005-00-659-1031 |
PR FR AADT02 Copy of PR with Zclinsg 8115-00-134-3655
FR @AD0250 Inbox Inbox
PR FPROOTE Test 061 2102 - Test S MYW01-02-123-4567
PR QA0001 Test 05131102 1005-00-921-5004
PR QAD0DA Test 05131102 1005-00-312-T177
- Select
Selected Documents to Transfer to nicole
Document Type Document Mumber Description MNEMN
PR QADDTO Test 06M 2502
PR Mod QADDT2-0001 PR Mod 06/1 202 5210-00-243-3349
PR QANDTS Test 06M 2f02 - Test So MWW01-02-123-4567
Femove |
0k Cancel |

WWarning: Applet Window

Figure 230: Document Search Window

9. Click the [OK] button in the Document Search window.
10. Click [Yes] to the Confirmation.

Note:  E-mail notifications are sent to the Transfer From user and Transfer To user informing
them of the documents that were transferred.
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Chapter 12: Help

The Help menu provides the PRweb user with In This Chapter...

various modes of user support including access to

PRweb online help, SPS/AcquiLine Help Desk, and Using the Help functions described
About PRweb. in this chapter, you can:

e Access PRweb online help
e Contact the help desk

e [earn more about PRweb

=10l x|

File Preferences Purchase Reguest QglEfl

PRuwweb Help..
i Contact Help Dezk. .
(2] Outhox i
D Archive About PRwehb.

I Iy

I.Java Applet Window

Figure 231: PRweb Help Menu
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PRweb Help

The PRweb Help menu option allows the AcquiLine PRweb user to access the on-line PRweb
Help Guide.

To access the PRweb Help Guide:

1. From the menu, select Help > PRweb Help.
The AcquiLine PRweb v2.3 Help window opens.

a AcquiLine PRweb 2.1 Help - Microsoft Internet Explorer provided by AMS

-8 x|
J File Edit Wiew Favorites Took  Help ﬁ
| #eack - = - QD 4} | Qsearch [Favortes (History | B S -
Jhgdrass I@ https:jvecotest/acquilinefHelp/master_introduction? jacquiline_prweb_help.htm j @Gu
| Uinks @70LA Acquiline SRweb  @]DLACEWES @]VECOCEWER @]VECOSRWED @]ArbaProd &]Acquling - PRweb & Trading Metworks Web Manager &1 Acquiling - PRweb 2.2
Showl 0|

AcquiLine PRweb v2.2 Help

Welcome to Acguiline PRwebvZ 2 Help.

There are many different ways to navigate among the topics ta find the information you need. Click on the How Do I... page to find answers to commaon FRweb guestions, or select

ausertype below to begin. To search far specific topics, enable the Table of Contents, Index, and Search features by clicking on the [Show] button above. To hide the navigational

pane and its components, click the Hide] button. The [Browse] huttons above (\i andib wiill allow you to browse sequentially through the topics in a given subject area. In

addition, you are able to use your Internet brawser's [Back] and [Forward] buttons as you would for pages on the Internet. Within each tapic, certain words andior phrases are

highlighted. Click an these words and phrases ta find outimportant infarmation about them

How Do I... ?: Help Topics

Functional User: Purchase Request Creation and Management

System Administrator: Site and Personnel Management

About AcquilLine PRweb
-y ¢
Acquil inc”
o powered aquisition solutions
|@ Dane

’_ré_ Local intranet
Figure 232: AcquiLine PRweb 2.3 Help — Microsoft Internet Explorer Window

2. Double-click on the desired topic.

Contact Help Desk

The Contact Help Desk menu option allows the PRweb user to access the PRweb Product

Support web page and submit/receive electronic questions/answers for functional and technical
issues.

To contact the SPS/AcquiLine Help Desk:

1. From the menu, select Help > Contact Help Desk.
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The PRweb Product Support web page opens a new Web browser window.

/3 Product Support | SP5/Acquiline Help Desk - Microsoft Internet Explorer provided by AMS =18 x|
J File Edit Mew Favorites Tools  Help ﬁ
J 4=Eack - = - @ tat | @Search (3] Favorites @Histury | %v =] - ‘&

Jngdress I@ http: ffacquiline. amsinc. comfacqueb_2. nsf{IDfS7 j @Gn |J Links **

| v

AcquiLine

Knowladge Base

Search the KB

Enterwordis) to search

Suite Info SPS'[AchILIne Help DeSk and select the red button

Overview

Zuaibility Search...
Product Features o
mmr';ﬁ:; :;fmers If you are experiencing problems or have questhns abogt any ofthe Acqm!_me mod_ules, you can
search the extensive SPS Knowledge Base far information regarding your issue. Click here to search
the SPS Knhowledge Base. If your question requires an AMS Help Desk representative, please have = Advanced Search
__ModuleInfo  yaur site's Autharized Caller(s) contact the SPS Help Desk
PRumeh
ey Taols
FiPueh Contact Us
“ueh —_—
Registration
Navigate | Product Support How to Ragister
Product Support -
Register Now
Help Desk _ Regiterom |
semilin g 5P AcouiLing & SPS Knowledae Base _—
Enowledge Baze Link to the Acquiline & SPS Knowledge Base
fequiline Training Heus [tems
Shop SPS
. Acouiline Training Calendar
Inforrmation on PRweh on-site, personalized and instructor-led training
Downloads
= Recert News
Bizottmare FRwsh w2.13 is available
Eipocumentation for dowrload

=l
|&] ’7 ,7 |4 mmternet 4

Figure 233: Product Support Web Page

2. Click on SPS Knowledge Base.
The AMS SPS Knowledge Base window opens.

Here you can find answers to the most frequently asked questions about PD* SPS-I or
PRweb. Other topics include Headlines, Work Stations and Help Desk Records.

AcquiLine PRweb v2.3 210 July 29, 2002
Functional User’s Guide



Chapter 12: Help

About PRweb

The About PRweb menu option allows the PRweb user to view the application name and version.
To open the About PRweb window, select Help = About PRweb from the desktop menu bar.
To return to the desktop, click the [Close] button.

% About PRweb x|
&CI!#{E}’

AcquiLine - PRweb
Releaze Yerzion 2.3

American Management Systems, Inc.

Java dpplet Window

Figure 234: About PRweb Window
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A

Access Rights

The privileges given to users by the System Administrator that determine whether they can view,
change, move, or delete an object owned by themselves or another user. Generally, also refers to
the privileges associated with menu choices and document creation. Access Rights are defined in
System Administration.

ACRN
Accounting Classification Reference Number. A two-position alpha or alphanumeric control code
used to relate the accounting classification citation to detailed line item information.

Active Window

The window in which you are currently working (not necessarily the window that opens on the
screen). The Title Bar of an active window is highlighted in a different color, usually blue, than
any other open window on the Desktop. Any new documents created are automatically placed in
the Active Window.

ADC

After Date of Contract. Used in lieu of specified delivery dates when the delivery of an item
cannot be established until a contract is in place. Calculated based on the effective date of a
released award or the delayed effective date (whichever is later). Delivery may be specified as a
certain period of time after award of the contract. Used as one of the delivery date options in Line
Item Detail.

AFATA

After First Article Test Acceptance. Used to define delivery dates when a First Article Test is
required. Used as one of the delivery date options in Line Item Detail.

AMS

American Management Systems, Inc. Located in Fairfax, VA, the prime contractor of AcquiLine
PRweb and PD”.

Approval

A PRweb process that permits authorized users to electronically approve procurement documents.
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Attachment

A third party file (e.g., Word or Excel or any third party software that is OLE 2.0 compliant) used
in the procurement process. As an attachment in AcquiLine, this file can be associated with a
document and is represented by an icon on the desktop.

Auto Calendar

A feature that allows the PRweb user to enter a date on a field from a calendar interface.

B

Buttons

Buttons in a window that initiate an immediate specific action; e.g., [Search], [Select], [Add] or
[Delete].

C

CLIN

Contract Line Item.

Contingent Approval

An approval action specifying that the user approves a document under certain conditions. If a
document is contingently approved, comments should be provided detailing why it has not been
“fully approved” in the field provided on the Approval Sheet.

Contacts

Names of key personnel in the Vendor and Organization profiles. Contact names display in the
appropriate fields in documents and may be used as search criteria in the Address Search
window.

D
DD254

A Contract Security Classification Specification form. This form provides general security
requirements for a particular requirement package.
Desktop

The user's workspace in PRweb. This workspace contains job-related tools (e.g., applications,
utilities, and reference materials), items being worked on, and files of completed actions (e.g.,
documents, spreadsheets, forms, and reports).

DFARS

Defense Federal Acquisition Regulation Supplement.

AcquiLine PRweb v2.3 213 July 29, 2002
Functional User’s Guide



Glossary of Terms

Drop-Down List Boxes

Boxes that “drop-down” to display a list of options. These are indicated with a downward
pointing arrow.

F

FAR

Federal Acquisition Regulation.

Fields

Rectangular boxes in which textual information is typed.

Folders

Containers used to organize multiple related files or documents.

G

Group

A common collection of users. Groups can be defined by office, position, or title. Group
information is maintained in System Administration.

GUI

Graphical User Interface. The software 'front-end' to most applications that allows the use of
windowing, menu, and mouse techniques.

H

Hypertext

A form of on-line help in which users “jump” or move easily between related topics by clicking on
a certain type of text. This is a feature in PRweb On-line Help.

I

Icons

Small pictures that represent files, applications, or documents.
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J

Job Order Number

A cost accounting number that links funding to a specific task or job; e.g., construction or ship
repair. In PRweb, job order numbers may be entered by any user. Access to job order numbers is
limited to specified users unless access is provided to all users in PD* System Administration. Job
order numbers are entered in procurement documents from the Funding Sources window.

L

Local Info

Local Information fields that are used to enter data that does not display elsewhere in PRweb or
PD?. Fields are designated locally to capture information needed for reporting and tracking
purposes.

Logon

Accessing the PRweb applet with a username and password.

M

Menu

A list of commands that typically appears in a bar across the top of a window directly below the
Title Bar.

Milestone Plan

A utility used in PD? to create a schedule for completion of a contracting action and to record
progress against the schedule.

MILSTRIP

Military Standard Requisitioning and Issue Procedure. Number may be entered in Line Item
Detail.

Multiple Deliveries

Refers to delivery information when a user has added more than one delivery in PD? to a line item.

N

NAICS

North American Industry Classification Standards. Code for the North American Industry
Classification System to classify individual businesses.
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NSN

National Stock Number. A thirteen-position alphanumeric code that specifically identifies an
item.

0]

OLE
Object Linking and Embedding. Provides the interface between PRweb and third party software.

Outbox

Object in which items are placed when they have been routed to other PRweb users. Displays as a
container on the PRweb desktop.

P

PD?

Procurement Desktop - Defense. Pronounced "PD Squared." The commercial software product
that the government acquired competitively to satisfy the requirements laid out by the Standard
Procurement System program office. A combination of operating environment, applications, and
utilities that run in Microsoft Windows.

PR

Purchase Request. The generic, non-service specific document in PRweb that is used to record the
requesting activity's requirement.

PR Mod

Purchase Request Modification. A document that is used to modify a released Purchase Request.

Preferences

A group of options that define the settings on a user's desktop.

R

Radio Buttons

Buttons that represent a group of mutually exclusive choices in a window. They are round and fill
with a dark circle when selected.

Refresh All
Allows the PRweb user to refresh all folders on the desktop to reflect changes.

Refresh Folder

Allows the PRweb user to refresh individual folders on the desktop to reflect changes.
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Reject

An action indicating a PR has been rejected. If a document has been rejected, comments should
be given in the field provided on the approval sheet.

Route Template

Allows the PRweb user to create his/her own specific route templates to complement current
approval processes. Only users with appropriate security rights can create route templates.
Routing

Sending PRs and attachments to PRweb and PD? users. Accessed from either the Purchase
Request File menu or desktop Purchase Request menu.

Routing Sheet

A form that specifies the users to whom a document is to be routed and the order in which that
routing is to occur.

S

Select

The process of clicking on or highlighting an object.

SPS

Standard Procurement System.

SubCLINs

Sub Contract Line Items.

System Administration

A series of tasks that the System Administrator uses to manage and support PRweb features, such
as security, access rights, user information, and templates. For more information on System
Administration, refer to the AcquiLine PRweb System Administrator’s Guide.

System Administrator

Title given to the person(s) responsible for creating and maintaining the data to support PRweb.
For more information on System Administration, refer to the AcquiLine PRweb System
Administrator’s Guide.

T

Tabs

Rectangular buttons above forms that enable the user to easily move between the parts of a form.

Title Bar

The space at the very top of a window that indicates the application or object being worked in.
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U

Universal Search Criterion

The percent sign (%) is used as the "wildcard" character in searches for vendors, organizations,
objects, and keywords. It can be used alone to search for all items in the database in a given
category or it may be used in conjunction with letters or words to narrow the search.

User

The individual person using PRweb. The user account is maintained in System Administration.
Each user has a username, password and contact profile.

W

Windows

Screens that display files and documents, and “hold” applications and utilities while they are being
used.
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